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Chapter 1 
Introduction 

The design/check of steel frames is seamlessly integrated within the program. 
Automated design at the object level is available for any one of a number of 
user-selected design codes, as long as the structures have first been modeled 
and analyzed by the program. Model and analysis data, such as material prop-
erties and member forces, are recovered directly from the model database, and 
no additional user input is required if the design defaults are acceptable. 

The design is based on a set of user-specified loading combinations. However, 
the program provides default load combinations for each supported design 
code. If the default load combinations are acceptable, no definition of addition-
al load combinations is required. 

Steel frame design/check consists of calculating the flexural, axial, and shear 
forces or stresses at several locations along the length of a member, and then 
comparing those calculated values with acceptable limits. That comparison 
produces a demand/capacity ratio, which typically should not exceed a value of 
one if code requirements are to be satisfied. The program follows the same re-
view procedures when it is checking a user-specified shape or when checking a 
shape selected by the program from a predefined list.   

The program also checks the requirements for the beam-column capacity ratio, 
checks the capacity of the panel zone, and calculates the doubler plate and con-
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tinuity plate thickness, if needed. The program does not do the connection de-
sign. However, it calculates the design basis forces for connection design. 

Program output can be presented graphically on the model, in tables for both 
input and output data, or in calculation sheets prepared for each member. For 
each presentation method, the output is in a format that allows the engineer to 
quickly study the stress conditions that exist in the structure, and in the event 
the member is not adequate, aid the engineer in taking appropriate remedial 
measures, including altering the design member without re-running the entire 
analysis. 

The program supports a wide range of steel frame design codes, including 
many national building codes. This manual is dedicated to the use of the menu 
option "Indian IS 800:2007." This option covers the “Indian Standard – Gen-
eral Construction in Steel – Code of Practice, Third Revision” (IS 2007).  

The design codes supported under “Indian IS 800:2007” are written in Newton-
millimeter units. All the associated equations and requirements have been im-
plemented in the program in Newton-millimeter units. The program has been 
enabled with unit conversion capability. This allows the users to enjoy the flex-
ibility of choosing any set of consistent units during creating and editing mod-
els, exporting and importing the model components, and reviewing the design 
results. 

1.1 Organization 
This manual is designed to help you quickly become productive using the 
“Indian IS 800:2007” steel frame design option. Chapter 2 addresses 
prerequisites related to modeling and analysis for a successful design in 
accordance with IS 800:2007. Chapter 3 provides detailed descriptions of the 
specific requirements as implemented in “Indian IS 800:2007.” Chapter 4 
provides detailed descriptions of the specific requirements for seismic loading 
as required by the specification IS 800:2007.  
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1.2 Recommended Reading/Practice 
It is strongly recommended that you read this manual and review any applica-
ble "Watch & Learn" SeriesTM tutorials, which are found on our web site, 
http://www.csiamerica.com, before attempting to design a steel frame. Addi-
tional information can be found in the on-line Help facility available from 
within the program. 
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Chapter 2  
Modeling, Analysis and Design Prerequisites 

This chapter provides an overview of the basic assumptions, design precondi-
tions, and some of the design parameters that affect the design of steel frames. 

For referring to pertinent sections of the corresponding code, a unique prefix is 
assigned for each code. 

• Reference to the IS 800:2007 code is identified with the prefix "IS." 

• Reference to the IS 1893 (Part 1):2002 code is identified with the prefix 
"IS 1893." 

2.1 Check and Design Capability 
The program has the ability to check adequacy of a section (shape) in accord-
ance with the requirements of the selected design code. Also the program can 
automatically choose (i.e., design) the optimal (i.e., least weight) sections from 
a predefined list that satisfies the design requirements. 

To check adequacy of a section, the program checks the demand/capacity 
("D/C") ratios at a predefined number of stations for each design load combina-
tion. It calculates the envelope of the D/C ratios. It also checks the other re-
quirements on a pass or fail basis. If the capacity ratio remains less than or 
equal to the D/C ratio limit, which is a number close to 1.0, and if the section 
passes all the special requirements, the section is considered to be adequate; 
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otherwise the section is considered to have failed. The D/C ratio limit is taken 
as 0.95 by default. However, this value can be overwritten in the Preferences 
(Chapter 3). 

To choose (design) the optional section from a predefined list, the program first 
orders the list of sections in increasing order of  weight per unit length. Then it 
starts checking each section from the ordered list, starting with the one with the 
least weight. The procedure for checking each section in this list for adequacy 
is exactly the same as described in the preceding paragraph. The program will 
evaluate each section in the list until it finds the least weight section that passes 
the code checks. If no section in the list is acceptable, the program will use the 
heaviest section but flag it as being overstressed. 

To check adequacy of an individual section, the user must assign the section 
using the Assign menu. In that case, both the analysis and design sections will 
be changed. 

To choose the optimal section, the user must first define a list of steel sections, 
the Auto Select sections list. The user must next assign this list, in the same 
manner as any other section assignment, to the frame members to be opti-
mized. The program will use the median section by weight when doing the ini-
tial analysis. Refer to the program Help for more information about Auto Se-
lect section lists. 

2.2 Analysis Sections vs. Design Sections 
Analysis sections are those section properties used to analyze the model when 
an analysis is run. The design section is whatever section is used in the steel 
frame design. It is possible for the last used analysis section and the current de-
sign section to be different. For example, an analysis may be run using a 
W18X35 beam, and then in the design, it may be found that a W16X31 beam 
worked. In that case, the last used analysis section is the W18X35 and the cur-
rent design section is the W16X31. Before the design process is complete, veri-
fy that the last used analysis section and the current design section are the 
same.  Refer to the program Help for more information about completing this 
task. 

The program keeps track of the analysis section and the design section sepa-
rately. Note the following about analysis and design sections: 
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 Assigning a frame section property assigns the section as both the analysis 
section and the design section. 

 Running an analysis always sets the analysis section to be the same as the 
current design section. 

 Assigning an Auto Select section list to a frame object initially sets the 
analysis and design section to be the section in the list with the median 
weight. 

 Unlocking a model deletes the design results, but it does not delete or 
change the design section. 

 Altering the Design Combinations in any way deletes the design results, 
but does not delete or change the design section. 

 Altering any of the steel frame design preferences deletes the design re-
sults, but does not delete or change the design section. 

2.3 Design and Check Stations 
For each design combination, steel frame members (beams, columns, and brac-
es) are designed (optimized) or checked at a number of locations (stations) 
along the length of the object. The stations are located at equally spaced seg-
ments along the clear length of the object. By default, at least three stations 
will be located in a column or brace member, and the stations in a beam will be 
spaced at most 0.5 meter apart (2 feet if the model has been created in US 
units). The user can overwrite the number of stations in an object before the 
analysis is run using the Assign menu. The user can refine the design along the 
length of a member by requesting more stations. 

2.4 Demand/Capacity Ratios 
Determination of the controlling D/C ratios for each steel frame member indi-
cates the acceptability of the member for the given loading conditions. The 
steps for calculating the D/C ratios are as follows: 

 The factored forces are calculated for axial, flexural, and shear at each de-
fined station for each design combination. The bending moments are calcu-
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lated about the principal axes. For I-Shape, Box, Channel, T-Shape, Dou-
ble-Angle, Pipe, Circular, and Rectangular sections, the principal axes co-
incide with the geometric axes. For Single-Angle sections, the design con-
siders the principal properties. For General sections, it is assumed that all 
section properties are given in terms of the principal directions. 

For Single-Angle sections, the shear forces are calculated for directions 
along the geometric axes. For all other sections, the program calculates the 
shear forces along the geometric and principal axes. 

 The design capacities are calculated for compression, tension, bending and 
shear based on the equations provided later in this manual. For flexure, the 
design capacities are calculated based on the principal axes of bending. For 
the I-Shape, Box, Channel, Circular, Pipe, T-Shape, Double-Angle and 
Rectangular sections, the principal axes coincide with their geometric axes. 
For the Angle sections, the principal axes are determined and all computa-
tions related to flexural stresses are based on that. 

The design capacities for shear is calculated along the geometric axes for 
all sections. For I-Shape, Box, Channel, T-Shape, Double-Angle, Pipe, 
Circular, and Rectangular sections, the principal axes coincide with their 
geometric axes. For Single-Angle sections, principal axes do not coincide 
with the geometric axes. 

 Factored forces are compared to design capacities to determine D/C ratios. 
In either case, design codes typically require that the ratios not exceed a 
value of one. A D/C ratio greater than one indicates a member that has ex-
ceeded a limit state. 

2.5 Design Load Combinations 
The design load combinations are the various combinations of the prescribed 
load cases for which the structure needs to be checked. The program creates a 
number of default design load combinations for steel frame design. Users can 
add their own design combinations as well as modify or delete the program de-
fault design load combinations. An unlimited number of design load combina-
tions can be specified. 
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To define a design load combination, simply specify one or more load cases, 
each with its own scale factor.  The scale factors are applied to the forces and 
moments from the load cases to form the factored design forces and moments 
for each design load combination.   

For normal loading conditions involving static dead load (DL), live load (LL), 
wind load (WL), earthquake load (EL), and dynamic response spectrum load 
(EL), the program has built-in default design combinations for the design code. 
These are based on the code recommendations.  

The default design combinations assume all static load response cases declared 
as dead or live to be additive.  However, each static load case declared as wind, 
earthquake, or response spectrum cases, is assumed to be non-additive with 
other loads and produces multiple lateral combinations.  Also static wind, 
earthquake and notional load responses produce separate design combinations 
with the sense (positive or negative) reversed. The notional load cases are add-
ed to load combinations involving gravity loads only. 

For other loading conditions involving moving load, time history, pattern live 
load, separate consideration of roof live load, snow load, and the like, the user 
must define the design load combinations in lieu of or in addition to the default 
design load combinations. If notional loads are to be combined with other load 
combinations involving wind or earthquake loads, the design load combina-
tions should be defined in lieu of or in addition to the default design load com-
binations. 

For multi-valued design combinations, such as those involving response spec-
trum, time history, moving loads and envelopes, where any correspondence  
between forces is lost, the program automatically produces sub-combinations 
using the maxima/minima values of the interacting forces. Separate combina-
tions with negative factors for response spectrum load cases are not  
required because the program automatically takes the minima to be the nega-
tive of the maxima response when preparing the sub-combinations described 
previously. 

The program allows live load reduction factors to be applied to the member 
forces of the reducible live load case on a member-by-member basis to reduce 
the contribution of the live load to the factored responses. 
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2.6 Second Order P-Delta Effects 
Modern design provisions are based on the principle that the member forces are 
calculated by a second-order elastic analysis, where the equilibrium is satisfied 
on the deformed geometry of the structure. The effects of the loads acting on 
the deformed geometry of the structure are known as the second-order or the  
P-Delta effects. The P-Delta effects come from two sources: global lateral 
translation of the frame and the local deformation of members within the 
frame. 

Consider the frame object shown in Figure 2-1, which is extracted from a story 
level of a larger structure. The overall global translation of this frame object is 
indicated by ∆. The local deformation of the member is shown as δ. The total 
second order P-Delta effects on this frame object are those caused by both ∆  
and δ. 

∆

Original position of frame 
element shown by vertical 
line

Position of frame element 
as a result of global lateral 
translation, ∆, shown by 
dashed line

Final deflected position of the 
frame element that includes the 
global lateral translation, ∆, and 
the local deformation of the 
element, δ

δ

δ

P

∆

Original position of frame 
element shown by vertical 
line

Position of frame element 
as a result of global lateral 
translation, ∆, shown by 
dashed line

Final deflected position of the 
frame element that includes the 
global lateral translation, ∆, and 
the local deformation of the 
element, δ

δ

δ

P
 

Figure 2-1 P-∆  and P-δ  effects 

The program has an option to consider P-Delta effects in the analysis. When 
you consider P-Delta effects in the analysis, the program does a good job of 
capturing the effect due to the ∆ deformation (P-∆ effect) shown in Figure  
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2-1, but it does not typically capture the effect of the δ deformation (P-δ   
effect), unless, in the model, the frame object is broken into multiple elements 
over its length. 

In design codes, required strengths are usually required to be determined using 
a second-order analysis that considers both P-∆  and P-δ  effects. Approximate 
second-order analysis procedures based on amplification of responses from 
first-order analysis for calculating the required flexural strengths are common 
in current design codes and have the following general form: 

( )δ δ= +CAP b nt s ltM M M   

where, 

CAPM  =  Required flexural design capacities 

ntM  = Required flexural capacities from first-order analysis of the 
member assuming there is no translation of the frame (i.e., asso-
ciated with the δ deformation in Figure 2-1) 

ltM  = Required flexural capacities from first-order analysis of the 
member as a result of lateral translation of the frame only (i.e., 
associated with the ∆ deformation in Figure 2-1) 

δ s  = Unitless amplification factor multiplying ltM  

δb  = Unitless amplification factor multiplying ( )δ+nt s ltM M  

A rigorous second order analysis (IS 4.4.2, 4.4.3.1) or the amplification of first 
order analysis results to estimate the effect of second order effects (IS 4.1.1, 
4.4.3.1, Annex B) is required. The program has the capability of performing 
both. In the first case, the required strengths are determined directly from the 
analysis results without any amplification factor δs (i.e., δs  is equal to 1). How-
ever, these amplification factors can always be overwritten by the user on a 
member-by-member basis, if desired, using the overwrite option. 

To properly capture the P-δ effect in a finite element analysis, each element, 
especially column elements, must be broken into multiple finite elements, 
which is not really desired for other reasons. Although a single element per 
member can capture the P-δ effect to some extent, the program considers that 
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inadequate. The program thus uses the δb factor even if the analysis considers 
the P-∆ effects. This is a conservative approach. 

Thus, in general, the steel frame design feature requires consideration of  
P-Delta effects in the analysis before the check/design is performed. Although 
one element per line object is generally adequate to capture the P-∆ effect, it is 
recommended to use more than one element per line object for the cases where 
both P-∆ and P-δ effects are to be considered. However, explicit manual break-
ing of the member into elements has other consequences related to member end 
moments and unbraced segment end moment. It is recommended that the 
members be broken internally by the program. In this way, the member is  
recognized as one unit, end of the members are identified properly, and P-∆ 
and P-δ  effects are captured better. 

2.7 Notional Load Cases 
Notional loads are lateral loads that are applied at each framing level and are 
specified as a percentage of the gravity loads applied at that level (IS 4.3.6). 
These are intended to account for the destabilizing effects of out-of-plumbness, 
geometric imperfections, inelasticity in structural members, and any other  
effects that could induce sway and that are not explicitly considered in the 
analysis. 

The program allows the user to create a Notional Load case as a percentage of 
the previously defined gravity load case to be applied in one of the global lat-
eral directions:  X or Y. The user can define more than one notional load case 
associated with one gravity load by considering different factors and different 
directions.  

Currently, the notional loads are automatically included in the default design 
load combinations that include lateral loads. Moreover, the user is free to modi-
fy the default design load combinations to include the notional loads with ap-
propriate factors and in appropriate load combinations. 
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2.8 Member Unsupported Lengths 
The column unsupported lengths are required to account for column slender-
ness effects for flexural buckling and for lateral-torsional buckling. The pro-
gram automatically determines the unsupported length ratios, which are speci-
fied as a fraction of the frame object length. Those ratios times the frame object 
lengths give the unbraced lengths for the member. Those ratios also can be 
overwritten by the user on a member-by-member basis, if desired, using the de-
sign overwrite option.  

Two unsupported lengths, L33 and L22, as shown in Figure 2-2 are to be consid-
ered for flexural buckling. These are the lengths between support points of the 
member in the corresponding directions.  The length L33 corresponds to insta-
bility about the 3-3 axis (major axis), and L22  corresponds to instability about 
the 2-2 axis (minor axis).  The length LLTB (also termed Lz), not shown in the 
figure, is also used for lateral-torsional buckling caused by major direction 
bending (i.e., about the 3-3 axis). 

 

Figure 2-2 Unsupported lengths 33l  and 22l  
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In determining the values for L22 and L33 of the members, the program recog-
nizes various aspects of the structure that have an effect on these lengths, such 
as member connectivity, diaphragm constraints, and support points.  The pro-
gram automatically locates the member support points and evaluates the corre-
sponding unsupported length. 

It is possible for the unsupported length of a frame object to be evaluated by 
the program as greater than the corresponding member length. For example, 
assume a column has a beam framing into it in one direction, but not the other, 
at a floor level.  In that case, the column is assumed to be supported in one di-
rection only at that story level, and its unsupported length in the other direction 
will exceed the story height. 

By default, the unsupported length for lateral-torsional buckling, LLTB, is taken 
to be equal to the L22 factor. Similar to L22 and L33, LLTB can be overwritten. 

The unsupported length for minor direction bending for lateral-torsional buck-
ling also can be defined more precisely by using “precise” bracing points in the 
Lateral Bracing option, which is accessed using the Design menu > Steel 
Frame Design > Lateral Bracing command. This allows the user to define the 
lateral bracing of the top, bottom, or both flanges. The bracing can be a point 
brace or continuous bracing. 

The program calculates the unbraced length to determine axial capacity based 
on the limit state of flexural buckling from this definition. Any bracing at the 
top or bottom, or both, is considered enough for flexural buckling in the minor 
direction. While checking moment capacity for the limit state of lateral-
torsional buckling (LTB) at a station the program dynamically calculates the 
bracing points on the compression flange at the left and at the right of the 
check station considering the sign of the moment diagram. This definition af-
fects only the unbraced lengths for minor direction bending (L22) and lateral-
torsional buckling (LLTB). This “exact” method of bracing definition does not 
allow the user to define unbraced lengths for major direction bending (L33). 

There are three sources of unbraced length ratio:  (1) “automatic” calculation, 
(2) “precise” bracing definition, (3) overwrites, with increasing priority in con-
siderations. “Automatic” calculation of the unbraced length is based on mem-
ber connectivity considering only the members that have been entered into the 
model. This misses the tiny bracing members. However, such automatically 
calculated bracing lengths are load combo (moment diagram) independent. 
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This can be reported easily. Similarly, the overwritten values are load combo 
independent. This allows the program to report the overwritten unbraced length 
easily. However, if the member has a “precise” bracing definition, the unbraced 
length can be different at different stations of the member along the length. Al-
so it can be load combo dependent. Thus, when the unbraced length is reported 
in the detailed design info, it is reported perfectly considering all three sources 
as needed. However, when reporting unbraced length on the model shown in 
the active window, the program-reported value comes from “automatic” calcu-
lation or from the overwrites if the user has overwritten it. 

2.9 Effective Length Factor (K) 
The effective length method for calculating member axial compressive strength 
has been used in various forms in several stability based design codes. The 
method originates from calculating effective buckling lengths, KL, and is based 
on elastic/inelastic stability theory. The effective buckling length is used to 
calculate an axial compressive strength, Nb,Rd, through an empirical column 
curve that accounts for geometric imperfections, distributed yielding, and 
residual stresses present in the cross-section.  

There are two types of K-factors in the “Indian IS 800:2007” code. The first 
type of K-factor is used for calculating the Euler axial capacity assuming that 
all of the member joints are held in place, i.e., no lateral translation is allowed. 
The resulting axial capacity is used in calculation of the k factor. This K-factor 
is named as K1 in this document. This K1 factor is always less than 1 and is not 
calculated. By default the program uses the value of 1 for K1. The program al-
lows the user to overwrite K1 on a member-by-member basis. 

The other K-factor is used for calculating the Euler axial capacity assuming 
that all the member joints are free to sway, i.e., lateral translation is allowed.  
The resulting axial capacity is used in calculating Pd. This K-factor is named K2 
in this document. This K2 is always greater than 1 if the frame is a sway frame. 
The program calculates the K2 factor automatically based on sway condition. 
The program also allows the user to overwrite K2 factors on a member-by-
member basis. If the frame is not really a sway frame, the user should over-
write the K2 factors.  
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Both K1 and K2 have two values:  one for major direction and the other for mi-
nor direction, K1minor, K1major, K2minor, K2major. 

There is another K-factor, Kltb, for lateral-torsional buckling. By default, Kltb is 
taken as equal to K2minor. However, the user can overwrite this on a member-by-
member basis. 

The rest of this section is dedicated to the determination of K2 factors. 

The K-factor algorithm has been developed for building-type structures, where 
the columns are vertical and the beams are horizontal, and the behavior is basi-
cally that of a moment-resisting frame for which the K-factor calculation is rel-
atively complex. For the purpose of calculating K-factors, the objects are iden-
tified as columns, beams, and braces. All frame objects parallel to the Z-axis 
are classified as columns. All objects parallel to the X-Y plane are classified as 
beams.  The remainders are considered to be braces. 

The beams and braces are assigned K-factors of unity. In the calculation of the 
K-factors for a column object, the program first makes the following four stiff-
ness summations for each joint in the structural model: 

c c
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c x

cE IS
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 =  
 ∑  b b

bx
b x
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 ∑  

c c
cy

c y

cE IS
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 =  
 ∑  b b

b y
b y

cE IS
L

 =  
 ∑  

where the x and y subscripts correspond to the global X and Y directions and 
the c and b subscripts refer to column and beam. The local 2-2 and 3-3 terms 

22 22EI L  and 33 33EI L  are rotated to give components along the global X and 
Y directions to form the ( )x

EI L  and ( )y
EI L  values. The correlation factor 

for effective flexural stiffness, c, is taken as 1, disregarding the code recom-
mendation (IS Table 35). Then for each column, the joint summations at END-
I and the END-J of the member are transformed back to the column local 1-2-3 
coordinate system, and the β-values for END-I and the END-J of the member 
are calculated about the 2-2 and 3-3 directions as follows: 
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Finally, if βI  and βJ  are known for a particular direction, the column K-
factors for the corresponding direction is calculated from the following rela-
tionship for α: 

( )
( )

0.5
1 2 1 2

1 2 1 2

1 0.2 0.12
1 0.8 0.6

 − β +β − β β
=  − β +β + β β 

K  

This relationship is the mathematical formulation for the evaluation of K-
factors for moment-resisting frames assuming sidesway to be uninhibited. For 
other structures, such as braced frame structures, the K-factors  for all members 
are usually unity and should be set so by the user. The following are some im-
portant aspects associated with the column K-factor algorithm: 

 An object that has a pin at the joint under consideration will not enter the 
stiffness summations calculated previously. An object that has a pin at the 
far end from the joint under consideration will contribute only 50% of the 
calculated EI value. Also, beam members that have no column member at 
the far end from the joint under consideration, such as cantilevers, will not 
enter the stiffness summation.  

 If rotational releases exist at both ends of an object for a particular direc-
tion, the corresponding K-factor is set to unity.  

 The automated K-factor calculation procedure can occasionally generate 
artificially high K-factors, specifically under circumstances involving 
skewed beams, fixed support conditions, and under other conditions where 
the program may have difficulty recognizing that the members are laterally 
supported and K-factors of unity are to be used.  

 All K-factors produced by the program can be overwritten by the user. 
These values should be reviewed and any unacceptable values should be 
replaced. 

 The beams and braces are assigned K-factors of unity. 
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The effective length factor K1 of column in non-sway frames is given by 

 
( )
( )

1 2 1 2

1 2 1 2

1 0.145 0.265
2 0.364 0.247
 + β +β − β β =
 − β +β − β β 

K  

If the member is assigned with a framing type of sway frame, K1 is used for Kz 
and Ky calculation, and K2 is used for Pd calculation. If the member is assigned 
with a framing type of Braced frame, K1 is used for both Kz and Ky calculation 
and also for Pd calculation. 

2.10 Effect of Breaking a Member into Multiple Elements 
The preferred method is to model a beam, column or brace member as one sin-
gle element. However, the user can request that the program break a member 
internally at framing intersections and at specified intervals. In this way, accu-
racy in modeling can be maintained at the same time that design/check specifi-
cations can be applied accurately. There is special emphasis on the end forces 
(moments in particular) for many different aspects of beam, column, and brace 
design. If the member is manually meshed (broken) into segments, maintaining 
the integrity of the design algorithm becomes difficult. 

Manually breaking a column member into several elements can affect many 
things during design in the program.  

1. The unbraced length:  The unbraced length is really the unsupported length 
between braces. If no intermediate brace is present in the member, the un-
braced length is typically calculated automatically by the program from the 
top of the flange of the beam framing the column at the bottom to the bot-
tom of the flange of the beam framing the column at the top. The automati-
cally calculated length factor typically becomes less than 1. If there are in-
termediate bracing points, the user should overwrite the unbraced length 
factor in the program. The user should choose the critical (larger) one. 
Even if the user breaks the element, the program typically picks up the un-
braced length correctly, provided that there is no intermediate bracing 
point. 

2. K-factor: Even if the user breaks the member into pieces, the program typi-
cally can pick up the K-factors correctly. However, sometimes it can not. 
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The user should note the K-factors. All segments of the member should 
have the same K-factor and that factor should be calculated based on the 
entire member. If the calculated K-factor is not reasonable, the user can 
overwrite the K-factors for all the segments. 

3. Cm factor: The Cm factor should be based on the end moments of unbraced 
lengths of each member and should not be based on the end moments of 
the member. The program already calculates the Cm factors based on the 
end moments of unbraced lengths of each segment. If the break-up points 
are the brace points, no action is required by the user. If the broken seg-
ments do not represent the brace-to-brace unsupported length, the program 
calculated Cm factor is conservative. If this conservative value is accepta-
ble, no action is required by the user. If it is not acceptable, the user can 
calculate the Cm factor manually for the critical combination and overwrite 
its value for that segment. 

4. C1 factor: The logic is similar to that for the Cm factor. 

5. Kz, Ky, and KLT factors:  This factor amplifies the factored moments for the 
P-δ  effect. In its expression, there are the Cm factor and the Euler Buckling 
capacity Pe. If the user keeps the unbraced length ratios (L33 and L22) and 
the K-factors (K33 and K,22) correct, the Kz, Ky, and KLT factors would be 
correct.  

If the user models a column with a single element and makes sure that the  
L-factors and K-factors are correct, the effect of Kz, Ky, and KLT factors will be 
picked up correctly. The factors Cm and C1 will be picked up correctly if there 
is no intermediate bracing point. The calculated Cm and C1 factors will be 
slightly conservative if there are intermediate bracing points. 

If the user models a column with multiple elements and makes sure that  
l-factors and ke-factor are correct, the effect of  Kz, Ky, and KLT factors will be 
picked up correctly. The factors Cm and C1 will be picked up correctly if the 
member is broken at the bracing points. The calculated Cm and C1 factors will 
be conservative if the member is not broken at the bracing points. 

 Effect of Breaking a Member into Multiple Elements 2 - 15 



 Steel Frame Design IS 800:2007 

2.11 Supported Framing Types 
The code (IS 800:2007) recognizes the following types of framing  
systems. 

Framing Type References 

SMF (Special Moment Frame) IS 12.11 

OMF (Ordinary Moment Frame) IS 12.10 

SCBF (Special Concentrically Braced Frame) IS 12.7 

OCBF (Ordinary Concentrically Braced Frame) IS 12.8 

EBF ( Eccentrically Braced Frame)* IS 12.9 

Secondary or Gravity only IS 12.1 

*No special provision for EBF is programmed. 

2.12 Continuity Plates 
In a plan view of a beam/column connection, a steel beam can frame into a 
column in the following ways: 

 The steel beam frames in a direction parallel to the column major direction, 
i.e., the beam frames into the column flange. 

 The steel beam frames in a direction parallel to the column minor direction, 
i.e., the beam frames into the column web. 

 The steel beam frames in a direction that is at an angle to both of the princi-
pal axes. 

To achieve a beam/column moment connection, continuity plates, such as 
shown in Figure 2-3, are usually placed on the column, in line with the top and 
bottom flanges of the beam, to transfer the compression and tension flange 
forces of the beam into the column. 

For connection conditions described in the last two bullet items, the thickness 
of such plates is usually set equal to the flange thickness of the corresponding 
beam. 
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Figure 2-3 Doubler Plates and Continuity Plates 
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However, for the connection condition described by the first bullet item, where 
the beam frames into the flange of the column, such continuity plates are not 
always needed. The requirement depends on the magnitude of the beam flange 
force and the properties of the column. 

The program investigates whether the continuity plates are needed based on the 
requirements of the selected code. Columns of  I-sections supporting beams of 
I-sections only are investigated. The program evaluates the continuity plate re-
quirements for each of the beams that frame into the column flange and reports 
the maximum continuity plate area that is needed for each beam flange. The 
continuity plate requirements are evaluated for moment frames only. 

2.13 Doubler Plates 
One aspect of the design of a steel framing system is an evaluation of the shear 
forces that exist in the region of the beam-column intersection known as the 
panel zone. Shear stresses seldom control the design of a beam or column 
member.  However, in a moment resisting frame, the shear stress in the beam-
column joint can be critical, especially in framing systems when the column is 
subjected to major direction bending and the web of the column resists the joint 
shear forces. In minor direction bending, the joint shear is carried by the col-
umn flanges, in which case the shear stresses are seldom critical, and the pro-
gram does therefore not investigate this condition. 

Shear stresses in the panel zone due to major direction bending in the column 
may require additional plates to be welded onto the column web, depending on 
the loading and the geometry of the steel beams that frame into the column, ei-
ther along the column major direction, or at an angle so that the beams have 
components along the column major direction. See Figure 2-3. When code ap-
propriate, the program investigates such situations and reports the thickness of 
any required doubler plates.  Only columns with I-shapes and only supporting 
beams with I-shapes are investigated for doubler plate requirements.  Also, 
doubler plate requirements are evaluated for moment frames only.  
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2.14 Frame Design Procedure Overwrites 
The structural model may contain frame elements made of several structural 
materials:  steel, concrete, aluminum, cold-formed steel and other materials. 
The program supports separate design procedures for each material type. By 
default the program determines the design procedure from the material of the 
frame member. 

The program allows the user to turn the design of specific members off and on 
by selecting No Design or Default from material. Overwriting the design pro-
cedure can be accessed from the Design menu > Overwrite Frame Design 
Procedure command. 

ETABS supports both regular steel frame design and composite beam design. 
The determination of design procedure is different. If the material is concrete, 
the design procedure is concrete. If the material is steel, the default design pro-
cedure can be steel frame design or composite beam design. If the section is of 
steel material, and the member satisfies a host of other criteria, such as the 
member is horizontal (beam), it supports a filled deck or slab, it is an I-shaped 
member, it is hinged at both ends and so on, then the default design procedure 
is taken as composite beam design; otherwise, the default design procedure is 
taken as steel frame design. ETABS allows the user to overwrite a steel mem-
ber frame design procedure to steel frame design, composite beam design, de-
fault, or no design. Change the design procedure by selecting the member(s) 
and clicking the Design menu > Overwrite Frame Design Procedure com-
mand. A change in design will be successful only if the design procedure is 
valid for that member, i.e., the program will not allow the user to change the 
design procedure for a steel frame object to concrete frame design. 

2.15 Interactive Design 
Interactive Design is a powerful mode that allows the user to review the design 
results for any steel frame design and interactively revise the design assump-
tions and immediately review the revised results. Note that a design must have 
been run for the interactive design mode to be available. Refer to the program 
Help for more information about interactive design. 
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2.16 Automated Iterative Design 
If Auto Select sections have been assigned to frame objects, ETABS can auto-
matically perform the iterative steel frame design process. To initiate the pro-
cess, first use the Design menu > Steel Frame Design > View/Revise Prefer-
ence command and set the maximum number of auto iterations to the maxi-
mum number of design iterations the program is to run automatically. Next, run 
the analysis. Then,  begin design of the structure, making sure that no objects 
are selected. 

The program will then start the cycle of (1) performing the design, (2) compar-
ing the last-used Analysis Sections with the Design Sections, (3) setting the 
Analysis Sections equal to the Design Sections, and (4) rerunning the analysis. 
This cycle will continue until one of the following conditions has been met: 

 The Design Sections and the last-used Analysis Sections are the same. 

 The number of iterations performed is equal to the number of iterations 
specified for the maximum number on the Preferences form. 

 Currently, this feature is absent in SAP2000. 

2.17 Choice of Units 
English as well as SI and MKS metric units can be used for input. The codes 
are based on a specific system of units. All equations and descriptions present-
ed in the subsequent chapters correspond to that specific system of units unless 
otherwise noted. For example, the IS 800:2007 code is published in millimeter-
Newton-second units. By default, all equations and descriptions presented in 
this manual correspond to millimeter-Newton-second units. However, any sys-
tem of units can be used to define and design a structure in the program.  
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Chapter 3 
Design using IS 800:2007  

This chapter provides a detailed description of the algorithms used by the 
programs in the design/check of structures in accordance with “IS 800:2007 – 
Indian Standard: General Construction in Steel – Code of Practice” (IS 2007). 
The implementation covers load combinations from “IS 800:2007,” which is 
described in Section 3.4 Design Loading Combinations in this chapter. The 
loading based on "IS 1893:2002" and “IS 875:1987” has been described in a 
separate document entitled “Automated Lateral Loads Manual” (IS 2007; CSI 
2007).  

For referring to pertinent sections of the corresponding code, a unique prefix is 
assigned for each code. 

• Reference to the IS 800:2007 code is identified with the prefix “IS.” 

• Reference to the IS 1893 (Part 1):2002 code is identified with the prefix 
“IS 1893.” 

• Reference to the IS 875 (Part 3):1997 code is identified with the prefix "IS 
875." 

• Reference to the ANSI/AISC 360-05 code (specialist literature) is identi-
fied with the prefix “AISC.” 
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3.1 Notations 
The following table provides a list of the symbols used in this manual, along 
with a short description. Where possible, the symbol from the design code is 
used in this manual. 

A Cross-sectional area, mm2 

Ae Effective section area, mm2 

Ag Gross cross-sectional area, mm2 

An Net effective area of cross-section, mm2 

Av Shear area, mm2 

Av2, Av3 Major and minor shear areas, mm2 

Aw Web area, mm2 

b Nominal dimension of plate in a section, mm  

bf Flange width, mm 

C1 Modification factor for elastic critical moment 

CmLT Equivalent uniform moment factor for lateral-torsional buck-
ling 

Cmy Equivalent uniform moment factor for minor bending 

Cmz Equivalent uniform moment factor for major bending 

D Outside diameter of pipes, mm  

d Overall depth or clear depth of member depending on section 
type, mm  

E Modulus of elasticity, N/mm2 

fcc 
Euler buckling stress = 

( )
2

2
E

KL
r

π  

fcd Design compressive stress, N/mm2 

fu Steel ultimate strength, N/mm2 



fy Steel yield strength, N/mm2 

fyw Steel yield strength of the web, N/mm2 

G Shear modulus, N/mm2  

h Overall depth of the section, mm 

hw Web height, mm 

I Moment of inertia, mm4 

I22, Iy Minor moment of inertia, mm4  

I33,Iz Major moment of inertia, mm4  

J St. Venant torsional constant for the section, mm4  

K Effective length factor 

K33, K22 Effective length K-factors in the major and minor directions  

KLT Moment magnification factor for lateral-torsional buckling 

KLTB Effective length K-factor for lateral-torsional buckling 

Ky Moment magnification factor for minor axis bending moment 

Kz Moment magnification factor for major axis bending moment 

L Laterally unbraced length of member, mm 

L22, L33 Laterally unbraced length of member for major and minor ax-
es bending, mm 

LLT Effective buckling length, mm 

LLTB Unbraced length for lateral-torsional buckling, mm 

M Design factored bending moment, N-mm 

Md Design bending resistance, N-mm 

Mdv Reduced design bending resistance accounting for shear,  
N-mm 

My, M22 Design bending moment about minor axis bending, N-mm 

Mz, M33 Design bending moment about major axis bending, N-mm 

N Factored applied axial force (tension, T, or compression, P) 



Ncr Elastic critical force, N 

Nd Design strength in tension, Td,  or compression strength due to 
yielding given by 0d g y mN A f= γ  

P Design axial compression force, N 

Pd Design compressive strength, N 

r Radius of gyration, mm 

r33, r22 Radii of gyration in the major and minor directions, mm 

rz Least radius of gyration for analysis sections, mm 

t Plate thickness, mm 

Td Design tension resistance, N 

Tdg Design tensile strength due to yielding of cross-section, N 

Tdn Design ultimate tensil strength due to rupture, N 

tf Flange thickness, mm 

tw Web thickness, mm 

V Design factored shear force, N 

Vcr Design shear buckling resistance, N 

Vd Design shear strength, N 

Ze Elastic section modulus, mm3 

Ze33,Ze22 Major and minor elastic section moduli, mm3 

Zp Plastic modulus, mm3 

Zp33,Zp22 Major and minor plastic section moduli, mm3 

φ Value for calculating the reduction factor χ 

φLT Value for calculating the reduction factor χLT 

α  Imperfection factor for axial compression 

αLT Imperfection factor for lateral-torsional buckling 

α1, α2 Coefficients used in an interaction equation (IS 9.3.1.1) 



β Reduction factor of moment capacity to account for shear 
forces 

βb Moment capacity adjustment factor for appropriate class of 
section 

χ Stress reduction factor for buckling 

χLT Stress reduction factor for lateral-torsional buckling 

ε Coefficient dependent on fy, 250 yf  

γM0 Partial factor for the resistance of cross-sections and buckling 

γM1 Partial factor for the resistance governed by ultimate stress 

λ Non-dimensional slenderness, yfKL
r Eπ

 for flexural buckling 

λp,λr,λs Slenderness parameters for classification 

λLT Non-dimensional slenderness for lateral-torsional buckling 

λw Non-dimensional web slenderness ratio 

ψ Ratio of moments in a segment 

3.2 Design Preferences 
The steel frame design preferences are basic assignments that apply to all steel 
frame members. Table 3-1 lists steel frame design preferences for "Indian IS 
800:2007." Default values are provided for all preference items. Thus, it is not 
necessary to specify or change any of the preferences. However, at least review 
the default values to ensure they are acceptable. Some of the preference items 
also are available as member-specific Overwrite items. The overwrites are 
described in the next section. Overwritten values take precedence over the 
preferences. Refer to the program Help for information about changing Preferences. 

Table 3-1: Steel Frame Design Preferences 
Item Possible Values Default Value Description 

Design Code  Design codes  
available in the  
current version 

AISC360-05/ 
IBC 2006 

The selected design code. Subsequent design is based 
on this selected code. 



Table 3-1: Steel Frame Design Preferences 
Item Possible Values Default Value Description 

Multi-Response Case 
Design 

 Envelopes,    
Step-by-Step, Last 
Step, Envelopes, 
All, Step-by-Step - 
All 

Envelopes Select to indicate how results for multivalued cases 
(Time history, Nonlinear static or Multi-step static) 
are considered in the design. Envelope considers 
enveloping values for Time History and Multi-step 
static and last step values for Nonlinear static. Step-
by-Step considers step-by-step values for Time His-
tory and Multi-step static and last step values for 
Nonlinear static. Last Step considers last values for 
Time History, Multi-step static and Nonlinear static. 
Envelope - All considers enveloping values for Time 
History, Multi-step static and Nonlinear static. Step-
by-Step - All considers step-by-step values for Time 
History, Multi-step static and Nonlinear static. Step-
by-Step and Step-by-Step - All default to the corre-
sponding Envelope if more then one multivalued 
case is present in the combo. 

Framing Type SMF, OMF, SCBF, 
OCBF, EBF,  
Secondary 

SMF This item is used for ductility considerations in the 
design. 

Importance Factor > 0 1.0 This is related to seismic design. This depends on the 
functional use of the structure, hazardous conse-
quences of its failure, post-earthquake functional 
needs, and so on (IS 1893 6.4.2). 

Seismic Zone Zone I, II, III, IV, V Zone V This affects seismic intensity. It depends on physical 
location of the structure (IS 1893 6.4.2, Table 2, 
Annex E). 

Consider P-Delta 
Done? 

Yes/No  It affects K-factor calculation. If P-∆ analysis is 
completed, K is taken as if the structure is braced. 

GammaM0 > 0 1.1 Partial factor for the resistance of cross-sections and 
buckling. 

GammaM1 > 0 1.25 Partial factor for the resistance of members to  
ultimate stress. 

Ignore Seismic Code? Yes, No No Toggle to consider (No) or not consider (Yes) the 
seismic part of the code in design. 

Ignore Special  
Seismic Load? 

Yes, No No Toggle to consider (No) or not consider (Yes) special 
seismic load combinations in design. 

Is Doubler Plate Plug 
Welded? 

Yes, No Yes Toggle to indicate if the doubler-plate is plug welded 
(Yes), or it is not plug welded (No). 

Consider  
Deflection? 

Yes, No Yes Toggle to consider the deflection limit (Yes) or to not 
consider the deflection limit (No). 



Table 3-1: Steel Frame Design Preferences 
Item Possible Values Default Value Description 

DL Limit, L/  ≥ 0 120 Deflection limit for dead load. Inputting 120 means 
that the limit is L/120. Inputting zero means no check 
will be made of this item. 

Super DL+LL  Limit, L/  ≥ 0 120 Deflection limit for superimposed dead plus live 
load. Inputting 120 means that the limit is L/120. 
Inputting zero means no check will be made of this 
item. 

Live Load Limit, L/  ≥ 0 360 Deflection limit for superimposed live load. Inputting 
360 means that the limit is L/360. Inputting zero 
means no check will be made of this item. 

Total Limit, L/  ≥ 0 240 Deflection limit for total load. Inputting 240 means 
that the limit is L/240. Inputting zero means no check 
will be made of this item. 

Total-Camber Limit, L/  ≥ 0 240 Limit for net deflection. Camber is subtracted from 
the total load deflection to get net deflection. Input-
ting 240 means that the limit is L/240. Inputting zero 
means no check will be made of this item. 

Pattern Live Load  
Factor 

 ≤1.0 0.75 The live load factor for automatic generation of load 
combinations involving pattern live loads and dead 
loads. 

Demand/Capacity 
Ratio Limit 

 ≤1.0 0.95 The demand/capacity ratio limit to be used for ac-
ceptability.  D/C ratios that are less than or equal to 
this value are considered acceptable. 

3.3 Overwrites 
The steel frame design Overwrites are basic assignments that apply only to 
those elements to which they are assigned. Table 3-2 lists steel frame design 
overwrites for "Indian IS 800:2007." Default values are provided for all Over-
write items. Thus, it is not necessary to specify or change any of the Over-
writes. However, at least review the default values to ensure they are accepta-
ble. When changes are made to Overwrite items, the program applies the 
changes only to the elements to which they are specifically assigned. Overwrit-
ten values take precedence over the Preferences. Refer to the program Help for 
information about changing Overwrites. 

Many of the items on the Overwrites form are similar to those found on the 
Preferences form.   



Table 3-2 Steel Frame Design Overwrites for "Indian IS 800:2007" 
Item Possible Values Default Value Description 

Current Design 
Section 

 Any defined steel 
section 

Analysis  
section 

The design section for the selected frame object. 
When this Overwrite is applied, any previous auto 
select section assigned to the frame object is  
removed. 

Fame Type SMF, OMF, SCBF, 
OCBF, EBF, Secondary 

From  
Preferences 

This item is used for ductility considerations in the 
design. 

Section Class Plastic,  
Compact,  

Semicompact,  
Slender 

Program  
determined 

Section class to be used. This can be “Class 1,” 
“Class 2,” “Class 3,” or “Class 4.” It determines the 
capacity of the sections and the interaction equations 
to be used. If not overwritten, it is calculated based 
on Table 2 of the code. 

Column Buckling 
Curve (z-z) 

a, b, c, or d Program  
determined 

Column buckling curve to be used for flexural buck-
ling about the major axis. This determines the axial 
compression capacity for buckling about the major 
axis. It determines the imperfection factors for buck-
ling curve. If not overwritten, it is taken from Table 
10 of the code. 

Column Buckling 
Curve (y-y) 

a, b, c, or d Program  
determined 

Column buckling curve to be used for flexural buck-
ling about the minor axis. This determines the axial 
compression capacity for buckling about the minor 
axis. It determines the imperfection factors for buck-
ling curve. If not overwritten, it is taken from Table 
10 of the code. 

Is Rolled Section? Yes./No Program  
determined 

It might affect the column buckling curve determina-
tion. 

Consider Deflection? Yes/No No Toggle to consider (Yes) or not consider (No) deflec-
tion. 

Deflection Check 
Type 

Ratio,  
Absolute,  

Both 

Program  
Determined 

Choose to consider deflection limitations as absolute, 
as a divisor of the beam length (relative),  or both. 

DL Limit, L/ ≥ 0 Program  
Determined 

Deflection limit for dead load. Inputting 120 means 
that the limit is L/120. Inputting zero means no check 
will be made of this item. 

Super DL+LL  
Limit, L/ 

≥ 0 Program  
Determined 

Deflection limit for superimposed dead plus live 
load. Inputting 120 means that the limit  is L/120. 
Inputting zero means no check will be made of this 
item. 

Live Load Limit, L/ ≥ 0 Program  
Determined 

Deflection limit for superimposed live load. Inputting 
360 means that the limit is L/360. Inputting zero 
means no check will be made of this item. 

Total Limit, L/ ≥ 0 Program  
Determined 

Deflection limit for total load. Inputting 240 means 
that the limit is L/240. Inputting zero means no check 
will be made of this item. 



Table 3-2 Steel Frame Design Overwrites for "Indian IS 800:2007" 
Item Possible Values Default Value Description 

Total-Camber Limit, 
L/ 

≥ 0 Program  
Determined 

Limit for net deflection. Camber is subtracted from 
the total load deflection to get net deflection. Input-
ting 240 means that the limit is L/240. Inputting zero 
means no check will be made of this item. 

DL Limit, abs ≥ 0 Program  
Determined 

Deflection limit for dead load. Inputting zero means 
no check will be made of this item. 

Super DL+LL Limit, 
abs 

≥ 0 Program  
Determined 

Deflection limit for superimposed dead plus live 
load. Inputting zero means no check will be made of 
this item. 

Live Load Limit, abs ≥ 0 Program  
Determined 

Deflection limit for superimposed live load. Inputting 
zero means no check will be made of this item. 

Total Limit, abs ≥ 0 Program  
Determined 

Deflection limit for total load. Inputting zero means 
no check will be made of this item. 

Total–Camber Limit, 
abs 

≥ 0 Program  
Determined 

Deflection limit for net deflection.  Camber is sub-
tracted from the total load deflection to get net  
deflection. Inputting a value of 240 means that the 
limit is L/240.  Inputting zero means no check will be 
made of this item. 

Specified Camber ≥ 0 Program  
Determined 

The specified amount of camber to be reported in the 
design output and to be used in the net deflection 
check. 

Net Area to Total 
Area Ratio 

≥ 0 Program  
Determined 

The ratio of the net area at the design section to gross 
cross-sectional area of the section. This ratio affects 
the design of axial tension members. Specifying 0 
means the value is program default which is 1. 

Live Load Reduction 
Factor 

≥ 0 Program  
Determined 

The reducible live load is multiplied by this factor to 
obtain the reduced live load for the frame object. 
Specifying zero means the value is program deter-
mined. 

Unbraced Length 
Ratio (Major) 

≥ 0 Program  
Determined 

Unbraced length factor for buckling about the frame 
object major axis; specified as a fraction of the frame 
object length. This factor times the frame object 
length gives the unbraced length for the object. Spec-
ifying zero means the value is program determined. 

Unbraced Length 
Ratio (Minor) 

≥ 0 Program  
Determined 

Unbraced length factor for buckling about the frame 
object minor axis; specified as a fraction of the frame 
object length. This factor times the frame object 
length gives the unbraced length for the object. Spec-
ifying zero means the value is program determined. 

Unbraced Length 
Ratio (LTB) 

≥ 0 Program  
Determined 

Unbraced length factor for lateral-torsional buckling 
for the frame object; specified as a fraction of the 
frame object length. This factor times the frame 
object length gives the unbraced length for the ob-
ject. Specifying zero means the value is program 
determined. 



Table 3-2 Steel Frame Design Overwrites for "Indian IS 800:2007" 
Item Possible Values Default Value Description 

Effective Length 
Factor Braced (K1 
Major) 

≥ 0 1.0 Effective length factor for buckling about the frame 
object major axis; specified as a fraction of the frame  
object length. This factor times the frame object 
length gives the effective length for the object.  Spec-
ifying zero means the value is program determined. 
For beam design, this factor is always taken as 1, 
regardless of any other value specified in the Over-
writes.  This factor is used calculating Ky, Kz and KLT 
factors. 

Effective Length 
Factor Braced 
(K1 Minor) 

≥ 0 Program  
Determined 

Effective length factor for buckling about the frame 
object minor axis; specified as a fraction of the frame  
object length. This factor times the frame object 
length gives the effective length for the object.  Spec-
ifying zero means the value is program determined. 
For beam design, this factor is always taken as 1, 
regardless of any other value specified in the Over-
writes. This factor is used calculating Ky, Kz and KLT 
factors. 

Effective Length 
Factor Sway (K2 
Major) 

≥ 0 Calculated Effective length factor for buckling about the frame 
object major axis assuming that the frame is not 
braced at the joints against sidewsway; specified as a 
fraction of the frame object length. This factor times 
the frame object length gives the effective length for 
the object. Specifying zero means the value is pro-
gram determined. For beam design, this factor is 
always 1, regardless of any other values specified in 
the Overwrites. The factor is used for axial compres-
sion capacity. 

Effective Length 
Factor Sway (K2 
Minor) 

≥ 0 Calculated Effective length factor for buckling about the frame 
object minor axis assuming that the frame is not 
braced at the joints against sidewsway; specified as a 
fraction of the frame object length. This factor times 
the frame object length gives the effective length for 
the object. Specifying zero means the value is pro-
gram determined. For beam design, this factor is 
always 1, regardless of any other values specified in 
the Overwrites.  The factor is used for axial compres-
sion capacity. 

Effective Length 
Factor (K LTB) 

≥ 0 Program  
Determined 

Effective length factor for lateral-torsional buckling; 
specified as a fraction of the frame object length. 
This factor times the frame object length gives the 
effective length for the object. Specifying zero means 
the value is program determined. For beam design, 
this factor is taken as 1 by default. The values should 
be set by the user. 

Bending Coefficient 
(C1) 

≥ 0 Program  
Determined 

Unitless factor; C1  is used in determining the critical 
buckling moment, Mcr, for arbitrary moment dia-
gram. Inputting zero means the value is program 
determined. 



Table 3-2 Steel Frame Design Overwrites for "Indian IS 800:2007" 
Item Possible Values Default Value Description 

Uniform Moment 
Factor (Cmz) 

≥ 0 Calculated Unitless factor; Cm for major axis bending is used in 
determining the interaction ratio. Inputting zero 
means the value is program determined. 

Uniform Moment 
Factor (Cmy) 

≥ 0 Calculated Unitless factor; Cm for minor axis bending is used in 
determining the interaction ratio. Inputting zero 
means the value is program determined. 

Uniform Moment 
Factor (CmLT) 

≥ 0 Program  
Determined 

Unitless factor; CmLT for lateral torsional buckling  
is used in determining the interaction ratio. Inputting 
zero means the value is program determined. 

Moment Coefficient 
(Kz) 

≥ 0 Program  
Determined 

Unitless moment magnification factor for major axis 
bending moment. Specifying zero means the value is 
program determined. 

Moment Coefficient 
(Ky) 

≥ 0 Program  
Determined 

Unitless moment magnification factor for minor axis 
bending moment. Specifying zero means the value is 
program determined.  

Moment Coefficient 
(K_LT) 

≥ 0 Program  
Determined 

Unitless moment magnification factor for lateral-
torsional buckling. Specifying zero means the value 
is program determined.  

Yield Stress, Fy ≥ 0 From  
Material 

Material yield strength used in the design/check.  
Specifying zero means the value is program deter-
mined. The program determined value is taken from 
the material property assigned to the frame object. 

Compressive  
Capacity, Pd 

≥ 0 Calculated Design axial compressive capacity. Specifying zero 
means the value is program determined. 

Tensile Capacity, Td ≥ 0 Calculated Design axial tensile capacity. Specifying zero means 
the value is program determined. 

Major Bending 
Capacity, Mdz 

≥ 0 Calculated Design bending moment capacity in major axis bend-
ing. Specifying zero means the value is program 
determined. 

Minor Bending 
Capacity, Mdy 

≥ 0 Calculated Design bending moment capacity in minor axis bend-
ing. Specifying zero means the value is program 
determined. 

Critical Buckling 
Moment, Mcr 

  Elastic critical moment calculated in accordance with 
Annex E. 

Major Shear  
Capacity, Vdy 

≥ 0 Calculated Design shear capacity force for major direction 
shear. Specifying zero means the value is program 
determined. 

Minor Shear  
Capacity, Vdz 

≥ 0 Calculated Design shear capacity force for minor direction 
shear. Specifying zero means the value is program 
determined. 



Table 3-2 Steel Frame Design Overwrites for "Indian IS 800:2007" 
Item Possible Values Default Value Description 

Demand/Capacity 
Ratio Limit 

≥ 0 Calculated The demand/capacity ratio limit to be used for 
 acceptability. Demand/capacity ratios that are less 
than or equal to this value are considered acceptable. 
Specifying 0 means the value is program determined. 

3.4 Design Loading Combinations 
The structure is to be designed so that its design strength equals or exceeds the 
effects of factored loads stipulated by the applicable design code. The default 
design combinations are the various combinations of the already defined analy-
sis cases, such as dead load (DL), live load (LL), wind load (WL), and horizon-
tal earthquake load (EL). 

For the IS 800:2007 code, the following default design combinations are gen-
erated by the program (IS 3.5.1, 5.3.3, Table 4): 

1.5DL  (IS 3.5.1, 5.3.3, Table 4, Line 1) 
1.5DL + 1.5L (IS 3.5.1, 5.3.3, Table 4, Line 2) 

1.5DL ± 1.5WL (IS 3.5.1, 5.3.3, Table 4, Line 4) 
0.9DL ± 1.5WL (IS 3.5.1, 5.3.3, Table 4, Line 4) 
1.2D + 1.2WL + 1.2W (IS 3.5.1, 5.3.3, Table 4, Line 3) 
1.2D + 1.2L ± 0.6W (IS 3.5.1, 5.3.3, Table 4, Line 2) 

1.5D ± 1.5E (IS 3.5.1, 5.3.3, Table 4, Line 4) 
0.9D ± 1.5E (IS 3.5.1, 5.3.3, Table 4, Line 4) 
1.2D + 1.2L ± 1.2E (IS 3.5.1, 5.3.3, Table 4, Line 3) 

The code is required to consider Notional Load in the design loading combina-
tions for steel frame design. The program allows the user to define and create 
notional loads as individual load cases from a specified percentage of a given 
gravity load acting in a particular lateral direction. These notional load cases 
should be considered in the combinations with appropriate factors, appropriate 
directions, and appropriate senses. Notional loads are automatically included in 
the default design load combinations that do not include lateral loads. Notional 
load patterns are only added to a load combination when their corresponding 
gravity load patterns are included in that combination, using the corresponding 



scale factor. For further information, refer to the "Notional Load Cases" section 
in Chapter 2. 

The combinations described herein are the default loading combinations only. 
They can be deleted or edited as required by the design code or engineer-of-
record. The program allows live load reduction factors to be applied to the 
member forces of the reducible live load case on a member-by-member basis 
to reduce the contribution of the live load to the factored responses. 

Live load reduction factors can be applied to the member forces of the live load 
case on a member-by-member basis to reduce the contribution of the live load 
to the factored loading. However, such a live load case must be specified as 
type Reducible Live Load. 

3.5 Design Strength 
The design strength for steel shapes is obtained by dividing the ultimate 
strength of the shape by a partial factor of safety, γm. The values of γm used in 
the program are as follows: 

Partial safety factor for buckling and yielding, γm0 = 1.10 (IS 5.4.1, Table 5) 

Partial safety factor for ultimate stress γm1 = 1.25. (IS 5.4.1, Table 5) 

Although not recommended, the program allows them to be overwritten in the 
preferences. If they are overwritten, the program uses them consistently. 

3.6 Classification of Sections for Local Buckling 
For the determination of the design strengths for axial compression and flex-
ure, the sections are classified as Plastic (Class 1), Compact (Class 2), Semi-
Compact (Class 3), or Slender (Class 4). The program classifies the individual 
sections in accordance with Table 3-3 (IS 3.7.2, Table 2). As specified in that 
table, a section is classified as Class 1, Class 2, Class 3 or Class 4 as applica-
ble.  

For a section to qualify as Plastic (Class 1), its flanges must be continuously 
connected to the web or webs and the width-thickness ratios of its compression 



elements must not exceed the limiting width-thickness ratios λp from Table 2 
of the code. If the width-thickness ratio of one or more compression elements 
exceeds λp, but does not exceed λr, the section is Compact (Class 2). If the 
width-thickness ratio of any element exceeds λr but does not exceed λs, the sec-
tion is Semi-Compact (Class 3). If the width-thickness ratio of any element ex-
ceed λs, the section is considered Slender (Class 4). The expressions of λp, λr, 
and λs, as implemented in the program, are reported in Table 3-1 (IS 3.7.2, Ta-
ble 2). 

The table uses the variables h, bf, tf, tw, b, t, D, d,  and so on. The variables b, d, 
D and t  are explained in the respective figures inside the table. The variables 
bf, tf, h, and tw are explained in Figure 3-1. 

For unstiffened elements supported along only one edge parallel to the direc-
tion of the compression force, the width shall be taken as follows (IS Table 2, 
Note 3): 

(a) For flanges of I-shaped members and tees, the width b is the clear distance 
between the lateral support and the free edge.  

 (b) For legs of angles and flanges of channels and zees, the width b is the full 
nominal dimension. 

(c) For plates, the width b is the distance from the free edge to the first row of 
fasteners or line of welds. 

(d) For stems of tees, d is taken as the full nominal depth of the section. 

Refer to Table 3-3 (IS Table 2) for the graphic representation of unstiffened el-
ement dimensions. 

For stiffened (internal) elements supported along two edges parallel to the di-
rection of the compression force, the width shall be taken as follows (IS Table 
2): 

(a) For webs of rolled or formed sections, d is the clear distance between 
flanges less the fillet or corner radius at each flange. 

(b) For webs of built-up sections, d is the distance between adjacent lines of 
fasteners or the clear distance between flanges when welds are used. 



(c) For flanges of rectangular hollow structural sections (HSS), the width b is 
the clear distance between webs. For webs of rectangular HSS, d is the 
clear distance between the flanges. 

Table 3-3 Limiting Width-Thickness Ratios of Compression Elements for 
Classification Sections 

Section 
Type 

Description 
of Element Example 

Width-
Thickness 

Ratio,  
( )λ  

Limiting Width-Thickness Ratios for Compression 
Element 

Plastic  
Class 1  

( )pλ  

Compact 
Class 2 

( )rλ  

Semi-Compact 
Class 3 

( )sλ  

D
ou

bl
y 

Sy
m

m
et

ric
 I-

Sh
ap

e 

Flexural  
compression 
of flanges of 

rolled  
I-Shapes 

 

fb t  9.4ε 10.5ε 15.7ε 

Flexural  
compression 
in flanges of  

built-up  
I-Shapes 

 

fb t  8.4ε 9.4ε 13.6ε 

Axial only 
compression 
in flanges of 

rolled  
I-Shapes 

 

fb t  9.4ε 10.5ε 15.7ε 

Axial only 
compression 
in flanges of 

built-up 
 I-Shapes 

 

fb t  8.4ε 9.4ε 13.6ε 

Flexure in web 

 

wd t  
1

84
1 r

ε
+

≥ 42ε 

if r ≤ 0 

1

105
1 r

ε
+

 

if r > 0 

1

105
1 1.5r

ε
+

≥ 42ε 

2

126
1 2r

ε
+

≥ 42ε 

Web in axial 
only  

compression 

 

wd t  NA NA 42ε 



Table 3-3 Limiting Width-Thickness Ratios of Compression Elements for 
Classification Sections 

Section 
Type 

Description 
of Element Example 

Width-
Thickness 

Ratio,  
( )λ  

Limiting Width-Thickness Ratios for Compression 
Element 

Plastic  
Class 1  

( )pλ  

Compact 
Class 2 

( )rλ  

Semi-Compact 
Class 3 

( )sλ  

C
ha

nn
el

 

Flexural 
 compression 

in flanges 

 

fb t  9.4ε 10.5ε 15.7ε 

Axial only 
compression 

in flanges 

 

fb t  9.4ε 10.5ε 15.7ε 

Flexure in web 

 

wd t  42ε 42ε 42ε 

Web in axial 
only  

compression 
 

wd t  42ε 42ε 42ε 

D
ou

bl
e 

C
ha

nn
el

 

Flexural  
compression 

in flanges 
 

fb t  9.4ε 10.5ε 15.7ε 

Axial only 
compression 

in flanges 
 

fb t  9.4ε 10.5ε 15.7ε 

Flexure in web 

 

wd t  42ε 42ε 42ε 

Web in axial 
only 

 compression 
 

wd t  42ε 42ε 42ε 



Table 3-3 Limiting Width-Thickness Ratios of Compression Elements for 
Classification Sections 

Section 
Type 

Description 
of Element Example 

Width-
Thickness 

Ratio,  
( )λ  

Limiting Width-Thickness Ratios for Compression 
Element 

Plastic  
Class 1  

( )pλ  

Compact 
Class 2 

( )rλ  

Semi-Compact 
Class 3 

( )sλ  

B
ox

 

Flexural or 
axial  

compression 
of flanges 

under major 
axis bending  

fb t  29.3ε 33.5ε 42ε 

Flexure in web 

 

wd t  
1

84
1 r

ε
+

> 42ε 

if r ≤ 0 

1

105
1 r

ε
+

 

if r > 0 

1

105
1 1.5r

ε
+

> 42ε 

2

126
1 2r

ε
+

> 42ε 

T-
Sh

ap
e 

Flexural or 
axial  

compression 
in flanges  

fb t  9.4ε 10.5ε 15.7ε 

 Compression 
in stems 

 
wd t  8.4ε 9.4ε 18.9ε 

D
ou

bl
e 

A
ng

le
 Any type of 

compression 
in leg 

 

b t  9.4ε 10.5ε 15.7ε 

Any type of 
compression 

in leg t

d

t

dd

 

b t  9.4ε 10.5ε 15.7ε 

( )b d t+  ――― ――― 25ε 

A
ng

le
 

Flexural  
compression 

in any leg 

t

b

d
t

b

d

 
 

b t  9.4ε 10.5ε 15.7ε 

Axial only 
compression 

in any leg 

 

b t  9.4ε 10.5ε 15.7ε 

( )b d t+  ――― ――― 25ε 



Table 3-3 Limiting Width-Thickness Ratios of Compression Elements for 
Classification Sections 

Section 
Type 

Description 
of Element Example 

Width-
Thickness 

Ratio,  
( )λ  

Limiting Width-Thickness Ratios for Compression 
Element 

Plastic  
Class 1  

( )pλ  

Compact 
Class 2 

( )rλ  

Semi-Compact 
Class 3 

( )sλ  

Pi
pe

 

Flexural  
compression 

 

D t  242ε  252ε  2146ε  

Axial only 
compression 

 

D t  ――― ――― 288ε  

Round 
Bar ――― ――― ――― Assumed Compact 

Rectan-
gular ――― ――― ――― Assumed Compact 

General ――― ――― ――― Assumed Compact 
SD  

Section ――― ――― ――― Assumed Compact 

Refer to Table 3-3 (IS Table 2) for the graphic representation of stiffened ele-
ment dimensions. 

The various parameters used in calculating the width-to-thickness ratio limits 
are defined as: 

250 yfε =  (IS Table 2 Notes) 

( )1
0w y

Pr
dt f

= −
γ

 (IS Table 2 Notes) 

2
0y

Pr
Af

= −
γ

 (IS Table 2 Notes) 

In classifying web slenderness of I-Shapes, Box, Channel, Double Channel, 
and all other sections, it is assumed that there are no intermediate stiffeners. 
Double Angles and Channels are conservatively assumed to be separated. 

Stress check of Slender sections is beyond the scope of this program. 
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Figure 3-1 IS 800:2007 Definition of Geometric Properties 
 



3.7 Calculation of Factored Forces and Moments 
The factored member loads that are calculated for each load combination are  
P, Mz, My, Vy, and Vz, corresponding to factored values of the axial force, the 
major and minor moments, and shears respectively. These factored loads are 
calculated at each of the previously defined stations. 

For slender compression members, the code recommends the use of a second 
order frame analysis, also called a P-∆ analysis, which includes the effect of 
sway deflections on the axial loads and moments in a frame. For an adequate 
and rational analysis, realistic moment curvature or moment rotation relation-
ships should be used to provide accurate values of deflections and forces. The 
analysis also should include the effect of foundation rotation and sustained 
loads. Because of the complexity in the general second order analysis of 
frames, the code provides an approximate design method that takes into 
account the “amplification” due to lateral deflections in columns (IS 4.4, 9.3 
Annex B).  

Hence, when using the “Indian IS 800:2007” code, it is recommended that the 
user include P-Delta analysis, including consideration of method, tolerances, P-
Delta load combinations and so on. With this analysis, the program can capture 
the lateral drift effect, i.e., the global effect or P-∆ effect, very nicely. But the 
program does not capture the local effect (P-δ effect) to its entirety because 
most often the column members are not meshed. To capture the local effects in 
columns, the program uses the approximate formula for amplified design 
moments as specified in the code (IS 9.3). Two major parameters in calculating 
the amplified design moments are the effective length factors for major and 
minor axis bending. The effective length factors for columns are computed 
using a code-specified procedure (IS 7.2.2, Annex D). If P-∆ analysis is not 
selected, the program calculates effective length factors, K, assuming the frame 
is a sway frame (sway unrestrained) (IS Annex D, Figure 28). However, if the 
P-∆ analysis is selected, the program assumes the member is prevented from 
further sway and assumes that the frame can be considered non-sway where  
K < 1 (IS Annex D, Figure 27). For more information on P-∆ and P-δ effects, 
please refer to Chapter 2 “Second Order P-Delta Effects.” See “Effective 
Length Factors (K)” also in Chapter 2 concerning the determination of K 
factors. 



3.8 Calculation of Factored Strengths 
The design strengths in compression, tension, bending, and shear are computed 
for Plastic (Class 1), Compact (Class 2), and Semi-Compact (Class 3) sections 
in accordance with the text in the following sections. The design flexural 
strength for all shapes of sections are calculated based on their principal axes 
of bending. For the Rectangular, I-Shape, Box, Channel, Double Channel, Cir-
cular, Pipe, T-Shape, and Double Angle sections, the principal axes coincide 
with their geometric axes. For the Single Angle sections, the principal axes are 
determined and all computations except shear are based on that. 

For all sections, the design shear strengths are calculated for directions aligned 
with the geometric axes, which typically coincide with the principal axes. 
Again, the exception is the Single Angle section.   

If the user specifies nonzero design strengths for one or more of the mem-
bers on the Steel Frame Overwrites form, those values will override the 
calculated values for those members. The specified capacities should be 
based on the principal axes of bending for flexure and on the geometric 
axes for shear. 

3.8.1 Design Tensile Strength 
This section applies to the members subject to axial tension. 

The factored design tension, T, in the members shall satisfy the following 
requirements: 

 1.0
d

T
T

≤  (IS 6.1) 

where 

 Td = design strength of the member. 

The design strength of a member under axial tension, Td is the lowest of the de-
sign strength due to yielding of the gross section, Tdg and the rupture strength 
of the critical section Tdn. 

 Td = min(Tdg, Tdn) (IS 6.1) 



The design strength of members under axial tension, Tdg as governed by the 
yielding gross section, is given by: 

 0g g y mT A f= γ  (IS 6.2) 

 fy  = yield stress of the material, 

 Ag = gross area of the cross-section, and 

 γm0 = partial safety factor for failure in tension by yielding (IS Table 5) 

The design strength in tension of the section, Tdn, as governed by rupture of net 
cross-sectional area, An, is given by 

 10.9dn n u mT A f= γ  (IS 6.3) 

where 

 An = net effective area of the member 

 fu  = ultimate stress of the material, and 

 γm1 = partial safety factor for failure at ultimate stress (IS Table 5) 

The values of Ag and An are defined as follows: 

The gross cross-section area, A, is based on nominal dimensions, ignoring fas-
tener holes and splice materials, and accounting for larger openings (IS 6.2). 

The net effective cross-section area, An, is defined as the gross cross-section ar-
ea, A, minus fastener holes and other openings. The net effective area, An, is as-
sumed to be equal to the gross cross-sectional area, Ag, by default. For mem-
bers that are connected with welds or members with holes, the n gA A ratio 
must be modified using the steel frame design Overwrites to account for the ef-
fective area. 

3.8.2 Design Compressive Strength 
The design compressive strength is taken as the minimum of the two limit 
states: Flexural Buckling; and Torsional and Flexural-Torsional Buckling. 



3.8.2.1 Flexural Buckling Limit State 
The design compressive strength, Pd, of a member is given by: 

 Pd = Ae fcd (IS 7.1.2) 

where, 

 Ae = effective section area; for Class I, Class 2, and Class 3 cross-
sections, it is taken as the gross sectional area (IS 7.3.2) and 

 fcd = design compressive stress. 

The design compressive stress, fcd, or axially loaded compression members is 
calculated using the following equation: 

 0
0 00.52 2

y m
cd y m y m

f
f f f

γ
= = χ γ ≤ γ

 φ + φ − λ 
 (IS 7.1.2.1) 

where 

φ = ( )[ ]20.5 1 0.2+ α λ − + λ  (IS 7.1.2.1) 

λ = non-dimensional effective slenderness ratio 
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fcc = Euler buckling stress = 
( )

2

2
E

KL
r

π  (IS 7.1.2.1) 

where 

KL r  = effective slenderness ratio or ratio of effective length, 
KL, to appropriate radius of gyration, r, 

α = imperfection factor given in IS Table 7 



χ = stress reduction factor 

 = 
( )0.52 2

1
 φ + φ − λ 

 (IS 7.1.2) 

γm0 = partial safety factor for material strength. 

The effective slenderness ratio, KL r , is given by: 

33 33 22 22

33 22
max ,KL K L K L

r r r
 

=  
 

 

For all sections except Single Angles, the principal radii of gyration r22 and r33 
are used. For Single Angles, the minimum (principal) radius of gyration, rz, is 
used instead of r22 and r33, conservatively, in computing .KL r  K33 and K22 are 
two values of K2 for the major and minor axes of bending. K2 is the effective 
length factor for actual (sway or nonsway) conditions. 

K is the effective length factor for flexural buckling. It can assume two values:  
K22 for buckling about the minor axis (y-y) and K33 for buckling about the ma-
jor axis (z-z). L is the unbraced length of the member. It also can assume two 
values, L22 and L33, for buckling about minor axis (y-y) and major axis (z-z), 
respectively. Please refer to Chapter 2 “Member Unsupported Length” and 
“Effective Length Factors (K)” for more details on L and K. 

The imperfection factor, α, is defined in Table 3-4 (IS 7.1.1, 7.1.2.1, Table 7) 
based on the buckling class. The buckling class is defined in Table 3-5 (IS 
7.1.2.2, Table 10) based on shapes, dimensional properties, and bending axis. 

Table 3-4: Imperfection Factors (IS 7.1.1, 7.1.2.1, Table 7) 
Buckling Class a b c d 

Imperfection Factor,  α 0.21 0.34 0.49 0.76 



Table 3-5: Buckling Class of Cross-Section (IS 7.1.2.2, Table 10) 

Section Shape Limits Axis Buckling 
Class 

Rolled I-Sections  

h/b > 1.2 
tf ≤ 40 mm Major 

Minor 
a 
b 

40 < tf ≤ 100 
mm 

Major 
Minor 

b 
c 

h/b ≤ 1.2 
tf ≤ 100 mm Major 

Minor 
b 
c 

tf > 100 mm Major 
Minor 

d 
d 

Welded I-Sections 
tf ≤ 40 mm Major 

Minor 
b 
c 

tf > 40 mm Major 
Minor 

c 
d 

Hollow Tube and Pipe Sections hot rolled any a 

Welded Box 
b/tf > 30 or h/tw > 30 any b 

b/tf  < 30 and h/tw < 30 any c 

Channel, Tee, Double Channel, 
General, Solid Sections, Section 
Designer 

none any c 

Angle and Double Angle Sections none any c 

3.8.2.2 Torsional and Flexural-Torsional Buckling 
Torsion and Flexural-Torsional Buckling are currently not covered in Indian IS 
800:2007 code. However, program incorporates the relevant clauses from 
AISC 360-05 code to cover the torsion and flexural torsion buckling which are 
important part of design. 

The limit states of torsional and flexural-torsional buckling are ignored for 
members with closed sections, such as Box and Pipe sections, solid sections 
(Circular and Rectangular), General sections and sections created using the 
Section Designer. 

The design compressive strength, Pd, of a member with I, Box, Channel, Dou-
ble Channel, Double Angle, and Angle sections is given by: 

 Pd = Ae fcd (IS 7.1.2) 



where, 

 Ae = effective sectional area 

 0 0cd y m y mf f f= χ γ ≤ γ  (IS 7.1.2.1) 

χ = 
( )0.52 2

1
 φ + φ − λ 

 (IS 7.1.2.1) 

φ = ( )[ ]20.5 1 0.2+ α λ − + λ  (IS 7.1.2.1) 

λ = y ef F   

α = imperfection factor for minor axis bending 

Fe is calculated from the following equations: 

I-Shapes and Double Channel Sections 
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Channel Sections 

( )
33 33

2
33

41 1
2

e ez e ez
e

e ez

F F F F HF
H F F

 +   = − −     + 
 (AISC E4-5) 

Double Angle and T-Shapes 

( )
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 (AISC E4-2) 

Single Angle Sections with Equal Legs 
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Single Angle Sections with Unequal Legs 
Fe is the lowest root of the cubic equation. 
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 (AISC E4-6) 
In the preceding equations,  

Cw  is the warping constant, in6 (mm6) 

x0, y0 are the coordinates of the shear center with respect to the centroid, x0 = 
0 for Double Angle and T-Shaped members (y-axis symmetry) 

0r  = 2 2 22 33
o o

g

I Ix y
A
+

+ + =  polar radius of gyration about the shear center  

  (AISC E4-7) 
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K22, K33   are effective length factors K2 in minor and major directions. 

Kz is the effective length factor for torsional buckling, and it is taken 
equal to KLTB in this program; it can be overwritten. 

L22, L33 are effective lengths in the minor and major directions. 

r22, r33  are the radii of gyration about the principal axes. 



LLT   is the effective length for torsional buckling, but it can be overwrit-
ten. 

For Angle sections, the principal moment of inertia and radii of gyration are 
used for computing Fe. Also, the maximum value of KL, i.e., max (K22L22, 
K33L33), is used in place of K22L22 or K33 L33 in calculating Fe22 and Fe33 in this 
case. The principal maximum value rmax is used for calculating Fe33 , and the 
principal minimum value rmin is used in calculating Fe22.  

3.8.3 Flexure Strength 
The factored moment resistance in the major and minor directions is based on 
the geometric shape of the section, the section classification for compactness, 
and the unbraced length of the member. The bending strengths are evaluated in 
accordance with the code as follows (IS 800:2007). 

The program uses the minimum of the flexure strength, Md, computed from 
Cross-Section Strength and Lateral-Torsional Buckling Strength (IS 8.2). 

3.8.3.1 Cross-Sectional Strength 
The cross-sectional flexural strengths of the member are calculated assuming 
the member is laterally fully supported. 

When the factored design shear force does not exceed 0.6 Vd, where Vd is the 
design shear strength of the cross-section, the design bending strength, Md is 
taken as: 

 0 01.2d b p y m e y mM Z f Z f= β γ ≤ γ  (IS 8.2.1.2) 

where 

βb = 1.0 for plastic and compact sections, 

 = e pZ Z for semi-compact sections, 

Zp  = plastic section modulus of the cross-section, 

Ze  = elastic section modulus of the cross-section, 



fy = yield stress of the material, 

γm0 = partial safety factor. 

When the design shear force (factored), V exceeds 0.6Vd, where Vd is the design 
shear strength of the cross-section, the design bending strength, Md is taken as 

Md = Mdv (IS 8.2.1.3) 

where 

Mdv  = design bending strength under high shear.  

When the factored shear force is less than or equal to 0.6 times the design shear 
strength (V ≤ 0.6 Vd), there is no reduction in moment capacity of the section 
necessary (IS 9.2.1). When the factored shear force is high (V > 0.6 Vd), the 
moment capacity of the section is reduced to Mdv which is calculated as follows 
(IS 9.2.2): 

(a) Plastic (Class 1) and Compact (Class 2) Sections 

 ( ) 01 1.2dv d fd e y mM M M Z f= − β + β ≤ γ  (IS 9.2.2(a)) 

 where 
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2 1 , if 0.6
d

d d

V V

V V V V

≤β = 
− >

 (IS 9.2.2(a)) 

 Md = plastic design moment of the whole section disregard-
ing high shear force effect (IS 8.2.1.2) considering web 
buckling effects (IS 8.2.1.1), 

 V = factored applied shear force, 

 Vd = design shear strength as governed by web yielding or 
web buckling (IS 8.4.1, 8.4.2), 

 Mfd = plastic design strength of the area of cross-section ex-
cluding the shear area, considering partial safety factor γm0, 

 Ze = elastic section modulus of the entire section. 

 Mfd is considered for I, Box, Channel, and Double Channel sec-



tions about the major axis bending and for only Box sections about 
the minor axis bending. For all other cases, Mfd is conservatively 
taken as zero. 

(b) Semi-Compact (Class 3) Section 

 ( ) 01dv d fd e y mM M M Z f= − β + β ≤ γ  (IS 9.2.2(b)) 

where β, Md, V, Vd, Mfd, and Ze are the same as defined previously. 

3.8.3.2 Lateral-Torsional Buckling Strength 

The design bending strength of a laterally unsupported beam as governed by 
lateral-torsional buckling is given by 

 Md = βbZp fbd (IS 8.2.2) 

where 

βb = 1.0 for Plastic (Class1) and Compact (Class 2) sections 

 = e pZ Z  for Semi-Compact (Class 3) sections, 

,p eZ Z  = plastic section modulus and elastic section modulus with re-
spect to extreme compression fiber 

fbd = design bending compressive stress, obtained as given in the 
following  

fbd = 0LT y mfχ γ  

χLT = bending stress reduction factor to account for lateral-torsional 
buckling, given by: 

{ }0.52 2

1 1χ = ≤
 φ + φ − λ 

LT

LT LT LT

 (IS 8.2.2) 

( ) 20.5 1 0.2LT LT LT LT φ = + α λ − + λ   (IS 8.2.2) 

αLT = the imperfection parameter. It is given by: 

= 0.21 for rolled steel section, and 



= 0.49 for welded steel section. 

The non-dimensional slenderness ratio, λ LT, is given by: 

1.2LT b p y cr e y crZ f M Z f Mλ = β ≤  (IS 8.2.2) 

where, 

Mcr = elastic critical moment calculated in accordance with Annex E. 

The elastic critical moment, Mcr, is based on gross cross-section properties and 
taken as: 
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 (IS Annex E, 8.2.2.1) 

where Iy, Iw, and It are the minor axis inertia, warping constant, and torsion con-
stant, respectively; LLT is the effective unbraced length for the lateral-torsional 
buckling mode, and C1 is defined as: 

2
1 1.88 1.40 0.52 2.7C = − ψ + ψ ≤  (EC3-1993 F1.1(6)) 

where ψ is the ratio of the smaller to the larger end moments. The value of C1 is 
also taken as 1.0 if the unbraced length is overwritten. The value of C1 can be 
overwritten on a member-by-member basis. 

C1 should be taken as 1.0 for cantilevers. However, the program is unable to 
detect whether the member is a cantilever. The user should overwrite C1 for 
cantilevers. The program also defaults C1 to 1.0 if the minor unbraced length, 
l22, is redefined to be more than the length of the member by the user or the 
program, i.e., if the unbraced length is longer than the member length. The 
Overwrites can be used to change the value of C1 for any member. 

Here LLT is the effective unbraced length for the lateral-torsional buckling 
mode. 

 LLT = KLTBLLTB 

where KLTB is the effective length factor for the lateral-torsional buckling mode, 
and LLTB is the unbraced length for the lateral-torsional buckling mode. For 
more details on these two factors, please refer to Chapter 2 of this manual. 



The lateral-torsional buckling resistance of Channels, Double Channels, Tees, 
Angles, Double Angles, and I-sections is calculated as described previously.  

Lateral-torsional buckling is not considered for Tubular, Box, or Solid sections. 
For General or Section Designer sections, the lateral-torsional buckling re-
sistance is taken as the design elastic moment resistance. 

3.8.4 Design Shear Strength 
The factored shear strengths are calculated for shears along the geometric axes 
for all sections. For I-Shape, Box, Channel, Double Channel, T-Shape, Double 
Angle, Pipe, Circular, and Rectangular sections, the principal axes coincide 
with their geometric axes. For Angle sections, principal axes do not coincide 
with their geometric axes. 

In calculating factored strength for shear, Vd, it is assumed that there is no in-
termediate stiffness used to enhance shear strength of a section (IS 8.4.2.2). 

The design shear strength, Vd, is taken as 

 0d n mV V= γ  (IS 8.4) 

where the nominal shear strength of a cross section, Vn, may be governed by 
plastic shear resistance (IS 8.4.1) or strength of the web, as governed by shear 
buckling (IS 8.4.2). 

3.8.4.1 Plastic Shear Resistance 
The nominal plastic shear resistance under pure shear is given by: 

 Vn = Vp (IS 8.4.1) 

where 

 
3

v yw
p

A f
V =  (IS 8.4.1) 

 Av = shear area, and 

 fyw = yield strength of the web. (IS 8.4.1) 



The shear area is calculated as given in the following (IS 8.4.1): 

 I and Channel sections: 

Major Axis Bending 

 Hot-Rolled — htw 

 Welded — dtw 

Minor Axis Bending 

 Hot-Rolled or Welded — 2btf 

 Rectangular Hollow Sections of Uniform Thickness 

Loaded parallel to depth (h) — ( )Ah b h+  

Loaded parallel to width (b) — ( )Ab b h+  

 Circular Hollow Tubes of Uniform Thickness — 2 A π  

 Plates and Solid Bars — A 

where, 

 A =  cross-section area, 

 b = overall breadth of a tubular section, breadth of I-section flanges, 

 d = clear depth of the web between flanges, 

 h = overall depth of the section, 

 tf = thickness of the flange, and 

 tw = thickness of the web. 

For all other sections, the equivalent elastic shear area is used. 



3.8.4.2 Resistance to Shear Buckling 

Resistance to shear buckling is verified when 67 ,wd t > ε  where 250 yfε =  

(IS 8.4.2.1). 

The nominal shear strength, Vn, of webs as governed by buckling is evaluated 
using the “simple post-critical method” assuming that the web has transverse 
stiffeners at the supports. The nominal shear strength is given by: 

 Vn = Vcr, (IS 8.4.2.2) 

where, 

 Vcr = shear force corresponding to web buckling, 

  = Avτb, 

 τb = shear stress corresponding to web buckling, determined as fol-
lows: 

 when λw ≤ 0.8 

 3 ,b ywfτ =  (IS 8.4.2.2) 

 when 0.8 < λw < 1.2 

 ( ) ( )1 0.8 0.8 3 ,b w ywf τ = − λ −   (IS 8.4.2.2) 

 when λw ≥ 1.2 

 ( )23 ,b yw wfτ = λ  (IS 8.4.2.2) 

 λw = non-dimensional web slenderness ratio for shear buckling stress,  

  = ( )τ ,3 ,yw cr ef  (IS 8.4.2.2) 

 τcr,e = the elastic critical shear stress of the web, 

  = 
( )[ ]
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 (IS 8.4.2.2) 



 µ = Poisson’s ratio, and 

 Kv = 5.35 when transverse stiffeners are provided only at supports 

  = ( )24.0 5.35 c d+  for 1.0c d <  

  = ( )25.35 4.0 c d+  for 1.0c d ≥  

where c, d are the spacing of the transverse stiffeners and the depth 
of the web, respectively. It is assumed that c is very large. 

3.9 Design of Members for Combined Forces 
Previous sections of this design manual address members subject to only one 
type of force, namely axial tension, axial compression, flexure, or shear. This 
section addresses the design of members subject to a combination of two or 
more of the individual forces. In the calculation of the demand/capacity (D/C) 
ratios, first, for each station along the length of the member, the actual member 
force/moment components are calculated for each design combination. Then, 
the corresponding capacities are calculated. Then, the D/C ratios are calculated 
at each station for each member under the influence of each of the design com-
binations. The controlling D/C ratio is then obtained, along with the associated 
station and design combination. A D/C ratio greater than the D/C ratio limit 
(whose default value is 1.0) indicates exceeding a limit state. 

During the design, the effect of the presence of bolts or welds is not consid-
ered. 

3.9.1 Combined Axial Force and Bending Moment 
Under combined axial force and bending moment, section strength as governed 
by material failure and member strength as governed by buckling failure shall 
be checked in accordance with IS 9.3.1 and IS 9.3.2, respectively. 



3.9.1.1 Design for Cross-Section Strength 
The combined effect of axial force and bending moments is checked in the 
same way whether the axial force is a tensile force or a compression force. 
There are minor exceptions that are noted in the relevant sections. 

3.9.1.1.1 Plastic (Class 1) and Compact (Class 2) Cross-Sections 
(a) For I, Rectangular Hollow, Circular Tube, and Solid Rectangular sec-

tions, the combined axial force (tension or compression) and bending 
moment is checked by taking the following summation of the utilization 
ratios for each force component as follows: 
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 (IS 9.3.1.1(a)) 

In the equation 9.3.1.1(a), there are two basic ratios — major axis bend-
ing (z) and minor axis bending (y) — and two factors α1 and α2 which 
determine the overall PMM ratio. The factors α1 and α2 in tern depend on 
the axial (n) ratio. Since α1 and α2 are often more than one, the overall ra-
tio can be smaller than the individual component ratios when the compo-
nent ratios are less than one. In this case the program reports either of the 
pure bending moment ratios or the axial ratio whichever governs as the 
PMM ratio as follows: 

1y

ndy

M
M

≤       (IS 9.3.1.1(ay)) 

1z

ndz

M
M

≤       (IS 9.3.1.1(az)) 

 1
d

N
N

≤  (IS 9.3.1.1(an)) 

where, 

 My, Mz = factored applied moments about the minor and major 
axis of the cross-section, respectively, 



 Mndy, Mndz = design reduced flexural strength under combined axial 
force and the respective uniaxial moment acting alone 
(IS 9.3.1.2), 

 N = factored applied axial force (tension, T, or compression, 
P), 

 Nd = design strength in tension, Td, as obtained from IS 6 or 
in compression due to yielding given by 0 ,d g y mN A f= γ  

 Mdy, Mdz = design strength under corresponding moment acting 
alone (IS 8.2), 

 Ag =  gross area of the cross-section, 

 γm0 = partial factor of safety in yielding, and 

 α1, α2  = constants as given in IS 9.3.1.1, Table 17, and taken as 
follows: 

– For I-sections and channels  

 α1 = 5n ≥ 1 (IS 9.3.1.1, Table 17) 

 α2 = 2 (IS 9.3.1.1, Table 17) 

– For Rectangular Hollow sections 

 1 2
1 66 6

1 1 13
.
. n

= ≤
−

α  (IS 9.3.1.1, Table 17) 

 2 2
1 66 6

1 1 13
.
. n

= ≤
−

α  (IS 9.3.1.1, Table 17) 

– For Circular Tube sections 

 1 2=α  (IS 9.3.1.1, Table 17) 

 2 2=α  (IS 9.3.1.1, Table 17) 

– For Solid Rectangular sections 



 3
1 1 73 1 8. . n= +α  (IS 9.3.1.1, Table 17) 

 3
2 1 73 1 8. . n= +α  (IS 9.3.1.1, Table 17) 

In all of the preceding cases, n is taken as 

 
d

Nn
N

=  (IS 9.3.1.1, Table 17) 

Mndy and Mndz are computed as follows: 

– For Solid Rectangular sections  

Mndz = ( )21dzM n−  (IS 9.3.1.2(a)) 

Mndy = ( )21dyM n−  (IS 9.3.1.2(a)) 

– For Welded I-sections  
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where, 
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– For Rolled I-sections  

 ( )1 11 1ndz dz dzM . M n M= − ≤  (IS 9.3.1.2 (c)) 
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– For Hollow Rectangular sections: 
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where 
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– For Hollow Circular Tube sections: 

 ( )1 71 04 1 .
ndz dz dzM . M n M= − ≤  (IS 9.3.1.2(e)) 

 ( )1 71 04 1 .
ndy dy dyM . M n M= − ≤  (IS 9.3.1.2(e)) 

In all of the preceding cases, n is taken as 
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 (IS 9.3.1.2) 

(b) For Tee sections, combined axial force and bending is conservatively 
checked by taking a linear summation of the utilization ratios for each 
force component as: 

 1.0y z

d dy dz

M MN
N M M

+ + ≤  (IS 9.3.1.1(b)) 

However, for this case the maximum longitudinal stress at three extreme 
points of the section are added with appropriate sign. That means that at 
the two extreme points on the flange, all three terms are added algebrai-



cally, whereas at the tip of the web, the minor axis bending term be-
comes zero. 

(c) For Channel, Double Channel, Double Angle, Angle, General, and Sec-
tion Designer sections, combined axial force and bending is conserva-
tively checked by taking a linear summation of the utilization ratios for 
each force component as: 

 1.0y z

d dy dz

M MN
N M M

+ + ≤  (IS 9.3.1.1(b)) 

The equation number reported in the output for the interaction equations in this 
section is really the section number 9.3.1.1. There are two interaction equations 
in this section of the code of which none of them are numbered in the code it-
self.  So the program named the equations as 9.3.1.1(a) and 9.3.1.1(b) to distin-
guish between them. Moreover, the program named the interaction equations 
9.3.1.1(az), 9.3.1.1(ay) and 9.3.1.1(an) while checking the component ratios.  

3.9.1.1.2 Semi-Compact (Class 3) Cross-Sections 
For all shapes, with the exception noted in the following text, the combined ax-
ial force and bending is conservatively checked by taking the linear summation 
of the utilization ratios for each force component: 

 1.0y z

d dy dz

M MN
N M M

+ + ≤  (IS 9.3.1.3) 

For Doubly Symmetric sections, the preceding equation is a representation of 
the code-specified equation given here: 
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γ
 (IS 9.3.1.3) 

As an exception for Circular and Pipe sections, an SRSS (Square Root of Sum 
of Squares) combination is made first of the two bending components before 
adding the axial load component, instead of the single algebraic addition as 
implied by the interaction equations given by IS 9.3.1.3. The resulting interac-
tion equation is given by the following: 
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 (IS 9.3.1.3) 

As an exception, for Tee sections, the terms are algebraically added for three 
extreme points of the section. See the previous section of this manual for de-
tails. 

3.9.1.2 Design for Overall Member Strength 
The combined effect of axial compression and bending with special emphasis 
to flexural and lateral-torsional buckling is checked using Section IS 9.3.2.2. 
The combined effect of axial tension and bending is checked in accordance 
with Sections IS 9.3.2.1 and IS 9.3.2.2, with the exception that the axial term is 
ignored while checking in accordance with Section 9.3.2.2. 

The program checks these equations assuming the section is prismatic. For 
nonprismatic sections the same equations are used. However the cross-section 
properties used are based on the section being checked. The user is advised to 
check the appropriateness of this method. 

3.9.1.2.1 Sections Under Flexure and Axial Compression 
The combined effect of axial compression and bending with special emphasis 
to flexural and lateral-torsional buckling is checked by calculating the utiliza-
tion ratios based on the following two interaction equations: 

 1.0my y z
y LT

dy dy dz

C M MP K K
P M M

+ + ≤  (IS 9.3.2.2(a)) 

 0.6 1.0my y mz z
y z

dz dy dz

C M C MP K K
P M M

+ + ≤  (IS 9.3.2.2(b)) 

where, 

 Cmy, Cmz = equivalent uniform moment factor in accordance with IS  
Table 18, 

 P = applied axial compression under factored load, 



 My, Mz = maximum factored applied bending moments about the y- 
and z-axis of the member, respectively, 

 Pdy, Pdz = design strength under axial compression as governed by 
buckling about the minor (y) and major (z) axis, respectively, 

 Mdy, Mdz = design bending strength about the y (minor) or z (major) axis 
considering laterally unsupported length of the cross-section 
(IS Section 8), 

 ( )1 0.2 1 0.8y y y yK n n= + λ − ≤ +           (IS 9.3.2.2) 

 ( )1 0.2 1 0.8z z z zK n n= + λ − ≤ +                        (IS 9.3.2.2) 
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where, 

 ny, nz = ratio of actual applied axial force to the design axial strength 
for buckling about the y and z axis, respectively, and 
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 CmLT = equivalent uniform moment factor for lateral-torsional 
buckling in accordance with IS Table 18 corresponding to 
the actual moment gradient between lateral supports against 
torsional deformation in the critical region under considera-
tion. 

The equation number reported in the output for the interaction equations in this 
section is really the section number 9.3.2.2. There are two interaction equations 
in this section of the code of which none of them are numbered in the code it-
self. So the program named the equations as 9.3.2.2(a) and 9.3.2.2(b) to distin-
guish between them. 



As an exception, for Circular and Pipe sections, an SRSS (Square Root of Sum 
of Squares) combination is made first of the two bending components before 
addition of the axial load component instead of simple algebraic addition as 
implied by the equation given previously. 

The Cmy, Cmz, and CmLT factors are the equivalent uniform moment factor for 
minor bending, major bending, and lateral-torsional buckling mode and are 
related to the distribution of moment over the braced segment. They are 
calculated depending on the loading condition and moment diagram based on 
Table 3-6 (IS Table 18, 9.3.2.2). All of the factors are calculated in the same 
way, except that appropriate bending axis and bracing direction are used. See 
Table 3-6 for details. 

Table 3-6 Equivalent Uniform Moment Factor (IS Table 18, 9.3.2.2) 

Bending Moment Diagram Range Case 

Cmy, Cmz, CmLT 
Two or More  

Concentrated Loads or 
Uniform Load 

Single Concentrated 
Load On Segment 

M ψ MM ψ M  

Linear moment diagram 

− 1 ≤ ψ ≤ 1 (a) 0.6 + 0.4ψ ≥ 0.4 

Mh ψ Mh

s s hM Mα =

MsMh ψ Mh

s s hM Mα =

Ms

 

End moment dominating ≥h sM M  

0 ≤ αs ≤ 1  − 1 ≤ ψ ≤ 1 (b) 0.2 + 0.8αs ≥ 0.4 0.2 + 0.8αs ≥ 0.4 

− 1 ≤ αs  ≤ 0 

0 ≤ ψ ≤ 1 (c) 0.1 − 0.8αs ≥ 0.4 − 0.8αs ≥ 0.4 

− 1 ≤ ψ ≤ 0 (d) 0.1 (1 − ψ) − 0.8αs  
≥ 0.4 

0.2 (− ψ) − 0.8αs  
≥ 0.4 

h h sM Mα =

ψ MhMh
Ms

h h sM Mα =

ψ MhMh
Ms

 

Span moment dominating ≥s hM M  

0 ≤ αh ≤ 1 − 1 ≤ ψ ≤ 1 (e) 0.95 − 0.05αh 0.90 + 0.10αh 

− 1 ≤  αh ≤  0 

0 ≤ ψ ≤ 1 (f) 0.95 + 0.05αh 0.90 + 0.10αh 

− 1 ≤ ψ ≤ 0 (g) 0.95 + 0.05αh(1+ 2ψ) 0.90 + 0.1αh(1+ 2ψ) 

For members with sway buckling mode, the equivalent uniform moment factor Cmy = Cmz = 0.9 
Cmy, Cmz, CmLT are obtained according to the bending moment diagram between the relevant braced point. 
 Moment Factor Bending Axis Points Braced in Direction 
 Cmz z-z y-y 
 Cmy y-y z-z 
 CmLT z-z z-z 
 



3.9.1.2.2 Sections Under Flexure and Axial Tension 
The combined effect of axial tension and bending with special emphasis to 
flexural and lateral-torsional buckling is checked by calculating the utilization 
ratios based on the following three interaction equations: 

1.0y z
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M MT A
M Z M M

−ψ + + ≤  (IS 9.3.2.1) 

1.0my y z
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M M

+ ≤  (IS 9.3.2.2(a)) 

0.6 1.0my y z
y z

dy dz

C M MK K
M M

+ ≤  (IS 9.3.2.2(b)) 

where, 

 T = factored tensile force, 

 A = area of the cross-section, 

 Zec = elastic section modulus of the section with respect to the extreme 
compression fiber, 

 ψ = 0.8, taken conservatively assuming M can vary independently, 

and all other parameters have been described in the previous section. 

The equation number reported in the output for the last two of the interaction 
equations in this section is really the section number 9.3.2.2. There are two in-
teraction equations in this section of the code of which none of them are num-
bered in the code itself. So the program named the equations as 9.3.2.2(a) and 
9.3.2.2(b) to distinguish between them. These two equations strictly applies to 
cases with axial compression and bending. However, they are still used in the 
case of axial tension and flexure to check flexural buckling mode. In this case 
the advantage of axial tension is ignored. 

As an exception, for Circular and Pipe sections, an SRSS (Square Root of Sum 
of Squares) combination is made first of the two bending components before 
addition of the axial load component instead of simple algebraic addition as 
implied by the equation given previously. 



3.9.2 Combined Axial Force, Bending Moment, and Shear Force 
The combined effect of axial force, shear force, and bending moment is 
checked in the same way as described in Section 3.9.1 “Combined Axial Force 
and Bending Moments,” with one exception. The exception is that moment ca-
pacity may be reduced depending on the value of shear force (IS 9.2.1, 9.2.2). 
This includes checking for cross-section strength (IS 9.3.1) only. The overall 
member strength (IS 9.3.2) is checked without consideration of the shear force. 

When the factored shear force is less than or equal to 0.6 times the design shear 
strength (V ≤ 0.6 Vd), there is no reduction in moment capacity of the section 
necessary (IS 9.2.1). When the factored shear force is high (V > 0.6 Vd), the 
moment capacity of the section is reduced to Mdv, which is calculated as de-
scribed in Section 3.8.3.1 (IS 9.2.2). 

3.9.3 Shear Stresses 
From the factored shear force values and the factored shear strength values at 
each station, for each of the load combinations, D/C ratios for shear in major 
and minor directions are produced as follows:  

1.0≤y

dy

V
V

 (IS 8.4) 

1.0≤z

dz

V
V

 (IS 8.4) 

3.10 Checking the Maximum Effective Slenderness Ratio of a 
Member 
The maximum effective slenderness ratio, KL/r values of a beam, strut or ten-
sion member shall not exceed those given in Table 3-7 (IS 3.8 Table 3). KL is 
the effective length of the member, and r is the appropriate radius of gyration. 

 33 33 22 22

33 22

max , .K l K lKl
r r r

 
=  

 
 



For all sections except Single Angles, the principal radii of gyration r22 and r33 
are used. For Single Angles, the minimum (principal) radius of gyration, rz , is 
used instead of r22 and r33 , conservatively, in computing .Kl r  K33 and K22 are 
two values of K2 for the major and minor axes of bending. 

Table 3-7 Maximum Values of Effective Slenderness Ratios (IS 3.8, Table 3) 

SI No. Member 

Maximum  
Effective  

Slenderness 
Ratio (KL/r) 

i) A member carrying compressive loads resulting from dead loads 
and imposed loads 180 

ii) A member subjected to compression forces resulting from a com-
bination with wind/earthquake actions only, provided the defor-
mation of such member does not adversely affect the stress in any 
part of the structure. 

250 

iii) Compression flange of a beam against lateral-torsional buckling. 300 

iv) Members always under tension 400 

 

 

 

 



 

Chapter 4 
Special Seismic Provisions 

This chapter provides a detailed description of the algorithms related to seismic 
provisions in the design/check of structures in accordance with the “IS 
800:2007 – Indian Standard: General Construction in Steel – Code of Practice” 
(IS 2007). The implementation covers load combinations from “IS 800:2007,” 
which are described in Section 4.4 Design Special Load Combinations in this 
chapter. The loading based on "IS 1893:2002" and “IS 875:1987” has been 
described in a separate document entitled “CSI Lateral Loads Manual” (IS 
2007; CSI 2007).  

For referring to pertinent sections of the corresponding code, a unique prefix is 
assigned for each code. 

 Reference to the IS 800:2007 code is identified with the prefix “IS.” 

 Reference to the IS 1893 (Part 1):2002 code is identified with the prefix “IS 
1893.” 

4.1 Design Preferences 
The steel frame design Preferences are basic assignments that apply to all of 
the steel frame members. The Preferences have been described previously in 
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the relevant section of Chapter 3. Table 3-1 lists the steel frame design 
Preferences. The following steel frame design Preferences are relevant to the 
special seismic provisions. 

 Importance Factor  

 Seismic Zone 

 Ignore Seismic Code? 

 Ignore Special Seismic Load? 

 Is Doubler Plate Plug Welded? 

4.2 Overwrites 
The steel frame design Overwrites are basic assignments that apply only to 
those elements to which they are assigned. The overwrites have been described 
previously in the relevant section of Chapter 3. Table 3-2 lists the steel frame 
design Overwrites. The following steel frame design overwrites are relevant to 
the special seismic provisions. 

 Frame Type 

4.3 Supported Framing Types 
The code now recognizes the types of framing systems identified in the table 
on the following page (IS 12). With regard to those framing types, the program 
has implemented specifications for all of the types of framing systems listed, 
except EBF. 

By default in the program, the frame type is taken as SMF. However, the 
default frame type can be changed in the Preferences for all frames or in the 
Overwrites on a member-by-member basis (Chapter 3). If a frame type 
Preference is revised in an existing model, the revised frame type does not 
apply to frames that have already been assigned a frame type through the 
Overwrites; the revised Preference applies only to new frame members added 
to the model after the Preference change and to the old frame members that 
were not assigned a frame type though the Overwrites.  
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Framing Type References 

SMF (Special Moment Frame) IS 12.11 

OMF (Ordinary Moment Frame) IS 12.10 

SCBF (Special Concentrically Braced Frame) IS 12.7 

OCBF (Ordinary Concentrically Braced Frame) IS 12.8 

EBF ( Eccentrically Braced Frame)* IS 12.9 

Secondary or Gravity only IS 12.1 

*No special provision for EBF is programmed. 

4.4 Design Special Load Combinations 
The program creates the default design load combinations based on the 
specification of the code. The default combinations have been described in 
"Design Loading Combinations" in Chapter 3. Additional information may be 
found in "Design Load Combinations" in Chapter 2. The user may change the 
default load combinations if the governing code is different. 

The program automatically considers seismic load effects, including 
overstrength factors (IS 12.2.3), as special load combinations that are created 
automatically from each load combination involving seismic loads. In that 
case, the earthquake force is represented by 2.5E. 

The special seismic combinations are 

 1.2DL + 0.5LL ± 2.5EL (IS 12.2.3(a)) 

 0.9DL ± 2.5EL (IS 12.2.3(b)) 

4.5 Special Check for Column Strength 
When / dP P  in columns due to a prescribed loading combination is greater 
than 0.4, the axial compressive and tensile strengths are checked in the absence 
of any applied moment and shear for the amplified seismic load combinations 
(IS 12.5.1.1). 
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 1.2DL + 1.0LL ± 2.5EL (IS 12.2.3(a)) 

 0.9DL ± 2.5EL (IS 12.2.3(b)) 

The preceding load combinations are used to calculate axial force only because 
other forces and moments are ignored. This axial capacity check is in addition 
to regular strength checks for the regularly specified load combinations (IS 
12.5). 

Those combinations are internal to the program. The user does NOT need to 
create additional load combinations for such load combinations. The special 
circumstances for which these load combinations are additionally checked are 
described later in this chapter, as appropriate. The special loading combination 
factors are applied directly to the load cases. It is assumed that any required 
scaling (such as may be required to scale response spectra results) has already 
been applied to the load cases.  

If the overwrite item "Ignore Special Seismic Load?" is set to yes, the 
preceding check will not be performed. 

4.6 Member Design 
This section describes the special requirements for designing a member. The 
section has been divided into subsections for each framing type. 

4.6.1 15BOrdinary Concentrically Braced Frames (OCBF) 
For this framing system, the following additional requirements are checked or 
reported (IS 12.7). 

 OCBF shall not be used in Seismic Zones IV and V and for buildings with 
an Importance Factor greater than 1 (I > 1) in Seismic Zone III. 

 When / dP P  in columns due to prescribed loading combinations without 
consideration of amplified seismic load is greater than 0.4, the axial com-
pressive and tensile strengths are checked in the absence of any applied 
moment and shear for the special seismic load combinations as described 
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previously in the "Special Check for Column Strength" section of this 
manual (IS 12.5.1). 

 All brace members are checked to be Plastic (Class 1), Compact (Class 2) 
or Semi-Compact (Class 3), but not Slender (Class 4) in accordance with 
Table 3-3 (IS 12.7.2.4; 3.7.2, Table 2). If this criterion is not satisfied, the 
program issues an error message. 

 The maximum /Kl r ratio of the braces is checked not to exceed 120 (IS 
12.7.2.1). If this criterion is not met, an error message is reported in the 
output.  

 The required compressive strength of braces shall not exceed 0.8 times Pd 
(IS 12.7.2.2). If this criterion is not met, an error message is reported in the 
output. 

4.6.2 4BSpecial Concentrically Braced Frames (SCBF) 
For this framing system, the following additional requirements are checked or 
reported (IS 12.8).  

 SCBF may be used in any seismic zone and for any bending irrespective of 
the value of the importance factor (IS 12.8.1.1). 

 When / dP P  in columns due to prescribed loading combinations without 
consideration of amplified seismic load is greater than 0.4, the axial com-
pressive and tensile strengths are checked in the absence of any applied mo-
ment and shear for the special seismic load combinations as described previ-
ously in the "Special Check for Column Strength" section of this manual (IS 
12.5.1). 

 All column and brace members are checked to be  Plastic (Class 1) in ac-
cordance with to Table 3-3 (IS 12.8.4.1, 12.8.2.5). If this criterion is not sat-
isfied, the program issues an error message. 

 The bracing member is designed such that gross area yielding governs over 
the net area rupture. This puts a limit on the net area of the gross area ratio 
(IS 12.8.2.7). If this criterion is not satisfied, the program issues an error 
message. 
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 The maximum Kl r ratio of the braces is checked not to exceed 160 (IS 
12.8.2.2). If this criterion is not satisfied, the program issues an error mes-
sage. 

4.6.3 Eccentrically Braced Frames (EBF) 
The code does not give any direct specification for this framing type. It rather 
refers to specialist literature. The program does not check any special 
requirement for the framing type. 

4.6.4 12BOrdinary Moment Frames (OMF) 
For this framing system, the following additional requirement is checked and 
reported (AISC SEISMIC 11).  

 OMF can not be used in seismic zones IV and V irrespective of the value of 
the importance factor and in seismic zone III for buildings with an im-
portance factor greater than unity (I > 1) (IS 12.10.1.1). 

 When / dP P  in columns due to prescribed loading combinations without 
consideration of amplified seismic load is greater than 0.4, the axial com-
pressive and tensile strengths are checked in the absence of any applied mo-
ment and shear for the special seismic load combinations as described previ-
ously in the "Special Check for Column Strength" section of this chapter (IS 
12.5.1). 

4.6.5 10BSpecial Moment Frames (SMF) 
For this framing system, the following additional requirements are checked or 
reported (IS 12.11).  

 This framing is applicable to any seismic zone and for any importance factor 
(IS 12.11.1.2). 

 When / dP P  in columns due to prescribed loading combinations without 
consideration of amplified seismic load is greater than 0.4, the axial com-
pressive and tensile strengths are checked in absence of any applied moment 
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and shear for the special seismic load combination as described previously in 
the "Special Check for Column Strength" section of this chapter (IS 12.5.1). 

 All beams and columns are required to be Plastic (Class 1) or Compact 
(Class 2) (IS 12.11.3.1). If this criterion is not satisfied, the program issues 
an error message. 

4.6.6 Secondary (Non-Seismic) 
No special consideration for this type of framing system is needed. 

4.7 Joint Design 
When checking for seismic load, the structural joints are checked and designed 
for the following.  

 Check the requirement of continuity plate and determination of its area  

 Check the requirement of doubler plate and determination of its thickness  

 Check the ratio of beam flexural strength to column flexural strength  

 Report the beam connection shear  

 Report the brace connection force  

4.7.1 20BDesign of Continuity Plates 
In a plan view of a beam-column connection, a steel beam can frame into a 
column in the following ways.  

 The steel beam frames in a direction parallel to the column major direction, 
i.e., the beam frames into the column flange.  

 The steel beam frames in a direction parallel to the column minor direc-
tion, i.e., the beam frames into the column web.  
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 The steel beam frames in a direction that is at an angle to both of the prin-
cipal axes of the column, i.e., the beam frames partially into the column 
web and partially into the column flange.  

To achieve a proper beam-column moment connection strength, continuity 
plates such as shown in Figure 2.3 of Chapter 2 are usually placed on the 
column, in line with the top and bottom flanges of the beam, to transfer the 
compression and tension flange forces of the beam into the column. For 
connection conditions described by the first bullet, where the beam frames into 
the flange of the column, such continuity plates are not always needed. The 
requirement depends on the magnitude of the beam-flange force and the 
properties of the column. This is the condition that the program investigates. 
Columns of I Sections only are investigated. The program evaluates the 
continuity plate requirements for each of the beams that frame into the column 
flange (i.e., parallel to the column major direction) and reports the maximum 
continuity plate area that is needed for each beam flange. The continuity plate 
requirements are evaluated for moment frames (OMF, SMF) only. No check is 
made for braced frames (OCBE, SCBF, EBF). 

4.7.2 21BDesign of Doubler Plates 
One aspect of the design of a steel framing system is an evaluation of the shear 
forces that exist in the region of the beam-column intersection known as the 
panel zone.  

Shear stresses seldom control the design of a beam or column member. 
However, in a Moment-Resisting frame, the shear stress in the beam-column 
joint can be critical, especially in framing systems when the column is 
subjected to major direction bending and the joint shear forces are resisted by 
the web of the column. In minor direction bending, the joint shear is carried by 
the column flanges, in which case the shear stresses are seldom critical, and 
this condition is therefore not investigated by the program.  

Shear stresses in the panel zone, due to major direction bending in the column, 
may require additional plates to be welded onto the column web, depending on 
the loading and the geometry of the steel beams that frame into the column, 
either along the column major direction or at an angle so that the beams have 
components along the column major direction. See Figure 2-3 of Chapter 2. 
The program investigates such situations and reports the thickness of any 
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required doubler plates. Only columns with I Shapes are investigated for 
doubler plate requirements. Also doubler plate requirements are evaluated for 
moment frames (OMF, SMF) only. No check is made for braced frames 
(OCBF, SCBF, EBF). 

The program calculates the required thickness of doubler plates using the 
following algorithms. The shear force in the panel zone is given by  

 
1

cos .
bn

bn n
p c

n n fn

MV V
d t=

θ
= −

−∑  

The available strength of the web panel zone for the limit state of shear 
yielding is determined as Vd using the same procedure as described in Section 
3.8.4 of this manual “Design Shear Strength.” There is an exception that Kv is 
based on the assumption that the transverse stiffener spacing, c, is equal to the 
center-to-center flange distance of the beam, and the panel depth is equal to the 
depth of the column. 

 c = db − tf 

 d = dc 

With this assumption, Kv, τcr,e, λw, and τb are calculated. Then Vd is taken as 

 Vn = tb dctwc (IS 8.4.2.2) 

If shear buckling does not control, τb becomes equal to 3yf  (IS 8.4.1). 

By using dV  = 0 ,n mV γ  the required column panel zone thickness pt  is found 

as follows.  

 0p m
p

b c

V
t

d
γ

=
τ

   

The extra thickness, or the required thickness of the doubler plate is given as 
follows: 

 = −dp p wt t t ,  

where, 
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yf  = Column and doubler plate yield stress  

pt  = Required column panel zone thickness  

fnt  = Flange thickness of n -th beam  

dpt  = Required doubler plate thickness  

fct  = Column flange thickness  

wt  = Column web thickness  

pV  = Required panel zone shear capacity  

cV  = Column shear in column above  

bn  = Number of beams connecting to column  

nd  = Overall depth of n -th beam connecting to column  

θn  = Angle between n -th beam and column major direction  

cd  = Overall depth of column  

bnM  = Factored beam moment from corresponding loading combination  

nV  = Nominal shear strength of panel  

The largest calculated value of dpt , calculated for any of the load combinations 

based on the factored beam moments and factored column axial loads, is 
reported.  

Doubler plate requirements for seismic design are evaluated for SMF only. No 
further check/design is performed for other types of frames.  

 For SMF, the panel zone doubler plate requirements that are reported will 
develop at least the beam moments equal to the expected plastic moment 
capacity of the beam ( )1.2 ,pM  or beam moments due to specified load 

combinations involving seismic load (IS 12.11.2.2). For seismic design, pV  
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is calculated using the equation given previously, except that pbM  is taken 

as 1.2 33y pf Z  (IS 12.11.2.1). All other calculations follow the same 

procedure as given previously. 

 For SMF, the program checks the following panel zone column web thick-
ness requirement:  

 
( ) ( )2 2

.
90

c fc b fbd t d t
t

− + −
≥  (IS 12.11.2.4) 

Here, t is taken as wc dpt t+ when the doubler plate is plug welded to prevent 

local buckling. In such cases, dpt is increased if necessary to meet this 
criterion. If the doubler plate is not plug welded to the web, t is taken as 

wct and also as dpt for checking both plates. If wct cannot satisfy the criteria, 

then a failure condition is declared. If dpt does not satisfy this criterion, then 

its value is increased to meet the criterion. If the check is not satisfied, it is 
noted in the output.  

4.7.3 22BWeak Beam Strong Column Measure 
Only for Special Moment Frames (SMF) the code requires that the sum of 
column flexure strengths at a joint should be more than 1.2 times the sum of 
beam flexure strengths (IS 12.11.3.2).  

 1.2pc

pb

M
M

≥
∑
∑

 (IS 12.11.3.2) 

where 

pcM∑  = sum of the moment capacity in the column above and below 
the beam centerline 

pbM∑  = sum of the moment capacity in the beam at the intersection of 
the beam and the column centerlines 
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To facilitate the review of the strong column weak beam criterion, the program 
will report a beam-column plastic moment capacity ratio for every joint in the 
structure.  

For the major direction of any column (top end), the beam-to-column-strength 
ratio is obtained as  

 1
1.2 cos
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 (IS 12.11.3.2) 

For the minor direction of any column, the beam-to-column-strength ratio is 
obtained as  
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where, 

majR  = Plastic moment capacity ratios, in the major directions of the 

column  

minR  = Plastic moment capacity ratios, in the minor directions of the 
column 

∗
pbnM  = Plastic moment capacity of -thn  beam connecting to the col-

umn  

θn  = Angle between the -thn  beam and the column major direc-

tion  

∗
,pcax yM  = Major and minor plastic moment capacities, reduced for axial 

force effects, of column above story level  

∗
,pcbx yM  = Major and minor plastic moment capacities, reduced for axial 

force effects, of column below story level  
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bn  = Number of beams connecting to the column  

The plastic moment capacities of the columns are reduced for axial force 
effects and are taken as  

 uc
pc c yc

g

P
M Z F

A
∗

 
 = −
 
 

 

The plastic moment capacities of the beams are amplified for taking the beam 
moment capacity at the centerline of the column, rather than at the face of the 
column, as  

 ∗ =pb yb b mvM F Z f   

where,  

bZ  = Plastic modulus of beam  

cZ  = Plastic modulus of column  

ybF  = Yield stress of beam material  

ycF  = Yield stress of column material  

ucP  = Axial compression force in a column for a given load 
combination  

gA  = Gross area of the column  

mvf  = The moment amplification factor. It is taken as the ratio of beam 
moment at the centerline of column to the moment of the column 
face. Factor mvf  is taken as follows:  

mvf  = 1 c

b

d
L

+  where,  

cd  = Depth of column section, and  

bL  = clear span length of the beam.  
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For the preceding calculations, the section of the column above is taken to be 
the same as the section of the column below, assuming that the column splice 
will be located some distance above the story level.  

4.7.4 23BEvaluation of Beam Connection Shears 
For each steel beam in the structure, the program will report the maximum 
major shears at each end of the beam for the design of the beam shear 
connections. The beam connection shears reported are the maxima of the 
factored shears obtained from the loading combinations.  

For special seismic design, the beam connection shears are not taken less than 
the following special values for different types of framing. The special seismic 
requirements additionally checked by the program are dependent on the type of 
framing used.  

 For SMF, the beam connection shear is taken as the maximum of those from 
regular load combinations and those required for the development of full 
plastic moment capacity of the beam. The shear strength need not exceed the 
required value corresponding to the special load combination in IS 12.2.3 
with amplified earthquake load. The connection shear for the development of 
the full plastic moment capacity of the beam is as follows:  

 
1.2

1.2 0.5pb
DL LL

h

CM
V V V

L
= + +  (IS 12.11.2.2) 

where, 

V  = Shear force corresponding to END I or END J of the beam 

C  = 0 if the beam ends are pinned, or for a cantilever beam 
= 1 if one end of the beam is pinned 
= 2 if no ends of the beam are pinned 

pbM  = Plastic moment capacity of beam  

hL  = Clear length of the beam 
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DLV  = Absolute maximum of the calculated beam shears at the 
corresponding beam ends from the factored dead load only 

LLV  = Absolute maximum of the calculated beam shears at the 
corresponding beam ends from the factored live load only 

 For OMF, the beam connection shear is taken as the maximum of the two 
values:  (a) maximum shear from the load combinations and (b) maximum 
shear based on beam moment capacity of the beam. 

The maximum shear from the load combinations is determined from all of 
the regular load combinations but not from the amplified seismic load 
combinations (IS 12.2.3). 

The maximum shear based on beam moment capacity is calculated for any 
load combination involving seismic load by replacing the seismic effect on 
shear force with the capacity shear as follows: 

 
1.2 pb

u DL LL
h

CM
V V V

L
= + +  (IS 12.10.2.1) 

All parameters in the preceding equation have been described previously in 
this section. The moment connection is assumed to be rigid. 

 For SCBF the beam connection shear is taken as the maximum of those from 
the regular load combination.  

 For OCBF the beam connection shear is taken as the maximum of those from 
the regular load combinations.  

 For EBF, the beam connection shear is taken as the maximum of those from 
the regular load combinations. 

If the beam-to-column connection is modeled with a pin in the program by 
releasing the beam end, it automatically affects the beam connection shear. 

4.7.5 24BEvaluation of Brace Connection Forces 
For each steel brace in the structure, the program reports the maximum axial 
force at each end of the brace for the design of the brace-to-beam connections. 
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The brace connection forces reported are the maxima of the factored brace 
axial forces obtained from the loading combinations.  

For special seismic design, the brace connection forces are not taken less than 
the following special values for different types of framing. The special seismic 
requirements additionally checked by the program are dependent on the type of 
framing used.  

Brace axial forces for seismic designs are evaluated for braced frames (SCBF,  
OCBF) only. No special checks are performed for moment frames (OMF, 
SMF).  

 For SCBF, the bracing connection force is taken as the following value (IS 
12.8.3.1): 

a. The expected yield strength in tension of the bracing member, deter-
mined as 1.1 y gf A  (IS 12.8.3.1(a)). 

 For OCBF, the bracing connection force is taken as the minimum of the two 
values (IS 12.7.3): 

a. The expected yield strength in tension of the bracing member, deter-
mined as 1.2 y gf A  (IS 12.7.3.1(a)). 

b. The maximum load effect of the amplified seismic load combination (IS 
12.2.3, 12.7.3.1(b)). 

 For EBF, no special requirements are checked. The user should refer to spe-
cialist literature. 
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Chapter 5  
Design Output 

The program has the capacity to create design output in four major ways – 
graphical display, file output, tabular display, and member specific detailed de-
sign information.  

The graphical display includes input and output design information for members 
visible in the active window; the display can be sent directly to a printer or saved 
to a file. The file output includes both summary and detail design data that can be 
saved in RTF, HTML and plain text formats.  The tabular display output in-
cludes both summary and detail design data that can be displayed or saved in 
many formats, including Excel, Access, RTF, HTML and plain text. The 
member specific detailed design information shows the details of the calcula-
tion.  

The following sections describe some of the typical graphical display, file out-
put, tabular display output, and member specific detailed design information. 
Some of the design information is very specific to the chosen steel design code. 
This manual addresses "Indian IS 800:2007" design code related output infor-
mation only.  
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5.1 Graphical Display of Design Information 
The graphical display of design output includes input and output design infor-
mation for all steel frame members that are visible in the active window. The 
graphical output can be produced in color or in gray-scaled screen display. The 
active screen display can be sent directly to the printer or saved to a file in sev-
eral formats.  

Input and output design information for the “Indian IS 800:2007” code includes 
the following. 

Table 5-1 Graphical Display of Design Information 
Design Input Information Design Output Information 

 Design sections 
 Design framing type 
 Live load reduction factors 
 Unbraced length ratios, L-factors,  

for major and minor direction of bending,  
and for lateral-torsional buckling 

 Effective length factors for braced condition, K1, 
for major and minor directions of bending 

 Effective length factors for sway condition, K2 
factors, for major and minor directions  
of bending 

 Effective length factor, KLTB, for  
lateral-torsional buckling 

 Cm factors for major and minor directions of 
bending, and for lateral-torsional buckling (Cmz, 
Cmy, CmLT) 

 Amplification factors (Kz, Ky, KLT) for major and 
minor directions of bending 

 C1 factors 
 Yield stress, fy  
 Design axial capacities (Pd, Td) 

 Design bending capacities (Mdz, Mdy, Mcr) 

 Design shear capacities (Vdy, Vdz) 

 P-M stress ratio values with members 
color-coded based on the ratio 

 P-M colors and shear stress ratio val-
ues 

 P-M ratio colors and no values 
 Continuity plate and doubler plate 

thickness 
 Beam/column capacity ratios 
 Beam connection shear 
 Brace connection axial force 
 Identify the P-M failure 
 Identify the shear failure 

 Identify all failures 

Note that only one of the listed items can be displayed on the model at a time.  

Use the Design menu > Steel Frame Design > Display Design Info command 
to plot design input and output values directly on the model. The Display Steel 
Design Results form shown in Figures 5-1 and 5-2 will display.  
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Figure 5-1 Choice of design input data for display on the model  
 in the active window 

  
Figure 5-2 Choice of design output data for display on the model  

 in the active window 

Choose the Design Output or Design Input option. One item can be selected 
from the drop-down list. For example, the P-M interaction ratios can be dis-
played by choosing the Design Output option and selecting P-M Ratio Colors & 
Values from the drop-down list. Click the OK button to display the PM-Ratio in 
the active window. A typical graphical display is shown in Figure 5-3.  
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Figure 5-3 A typical graphical display 

The graphics can be displayed in 3D or 2D mode. The standard view transfor-
mations are available for all steel design information displays. Several buttons 
on the toolbar can be used to switch between 3D and 2D views. Alternatively, 
click the View menu and the Set 3D View or Set 2D View commands.  

The onscreen graphical display can be sent to printer using any of the following 
commands. Use the File menu > Print Graphics command to print the active 
window. To capture the graphical display in a file for printing through another 
application, use the File menu > Capture Enhanced Metafile command to 
create an .emf file, or use the File menu > Capture Picture command to create 
a bitmap (.bmp) file. Create a screen capture of the active window using the Alt+ 
Print Screen keyboard keys or create a screen capture of the entire window 
using the Ctrl + Print Screen keyboard keys. Then use the Ctrl+V keyboard 
keys to paste the saved image into Paint or other graphical program.  

By default the graphical displays are in color. It may be advantageous to view or 
present the display in gray-scale graphics or using a white background. Use the 
Options menu > Color command to set these options.  

5 - 4 Graphical Display of Design Information 



 Chapter 5 Design Output  
 

5.2 Tabular Display of Design Information 
In addition to model definition and analysis results, the design information for 
all steel frame members or for only selected members can be displayed in tabular 
spreadsheet format. Currently, the program generates design summary data, 
PMM design details and shear design details. The tabular spreadsheet output can 
be displayed by selecting the Display menu > Show Tables command to access 
the Choose Tables for Display form, an example of which is shown in Figure 
5-4. That form can be used to choose which tables or sets of tables are to be 
displayed.  

 
Figure 5-4 Choice of design data tables for tabular display 

The names of the tables are displayed in a tree structure, which can be collapsed 
or expanded by clicking on an item in the tree. Click on the small check boxes 
preceding the items to select those tables for display. If a branch of the tree is 
selected, all of the tables under that branch are selected. The selected set of ta-
bles can be saved as a Named Set using the Save Named Set button. This named 
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set can be used in the future for quick selection. If one or more frame members 
are selected on the structural model before accessing the Choose Tables for 
Display form, the Selection Only check box will be checked when the form 
displays and, the program will display information for the selected members 
only; uncheck the check box to display information for all applicable members 
in the model. If the Show Unformatted check box is checked, the numbers will 
be displayed unformatted, instead of being displayed using a limited number of 
decimal digits. The unformatted option provides higher precision output that can 
then be copied into other programs.  

Use the other buttons in the form to tailor the data display. For example, click the 
Select Load Patterns button to specify which load patterns are to be included in 
the display of model definition data; click the Select Load Case and Modi-
fy/Show Options to specify which load cases are to be included and how 
analysis results are displayed.  

After selecting all of the tables for steel frame design and the display options, 
click the OK button to display a form showing one of the selected design tables, 
with a drop-down list in the upper right-hand corner of the form that can be used 
to select other tables for display. A typical design table is shown in Figure 5-5.  

Use the scroll bars on the bottom and right side of the tables to scroll right and 
left or up and down if portions of the data table can not be displayed in the form's 
display area. The columns can be resized by clicking the left mouse button on 
the separator of the headers, holding down the left mouse button and then 
dragging the mouse to the left or right. Reset the column widths to their default 
values by selecting the Format-Filter-Sort menu > Reset Default Column 
Widths command on the form. The table can be split into two or more tables by 
clicking on the small black rectangular area near the bottom-left corner of the 
table, holding down the left mouse button, and then dragging the mouse button 
to the left or right. Repeat this process to add more splits. Use the split and 
horizontal scroll bar to put two columns side by side for easier comparison. The 
splits can be removed by selecting the Format-Filter-Sort menu > Remove 
Splits command on the form. Alternatively, remove the split by clicking, hold-
ing and dragging the left mouse button to merge the split key to its original lo-
cation.  
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Figure 5-5  A typical tabular display of design data 

Select multiple consecutive columns by putting the cursor on the header, holding 
down the mouse button, and then dragging the mouse button left or right. Al-
ternatively, depress the Shift key and click the left mouse button to select a range 
of columns.  

Each of the individual fields (columns) can be formatted. Fields with text in-
formation can be set for specific types of alignment (center, left, right) and to 
specific widths. In addition to setting the alignment and column widths, fields 
with numeric data can be set for the maximum number of characters, zero tol-
erance, number of decimal digits and so forth. The tables can be formatted, fil-
tered and sorted using multiple criteria accessed using the Format-Filter-Sort 
menu on the form. Filtering and sorting features can be useful in identifying 
critical cases. After specifying the table formatting information, save it to a 
format file that can be used in the future by selecting the appropriate feature 
available under the Format-Filter-Sort menu. 

The current table (i.e., the table in the active window) can be exported to Excel, 
Access, .rtf., .html, and plain text formats. In both Excel spreadsheet and Access 
database formats, the tables can have many columns, making the tables very 
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wide. In .rft and .html formats, the tables are split at convenient points to make a 
reasonably printable document. In plain text format, the tables can be saved with 
or without the splits. To export a table to Excel, for example, select the File 
menu > Export Current Table > To Excel command. The program will export 
the entire table to an Excel spreadsheet workbook and will automatically open 
the file in MS Excel. Similarly, if the table is exported to other formats, the 
default editor specific to that format will open the document, provided that the 
editor is available in the computer. The table will be saved in that format only if 
the relevant editor is not available. Instead of exporting or displaying the cur-
rently displayed table, the entire set of available tables can be exported and 
displayed in the afore-mentioned formats by selecting the File menu and the 
appropriate submenu command. With these exporting and display features, the 
tables can be saved in many required formats and can be printed. Many other 
features of the design tables are left for the user to discover by using the pro-
gram. 

The preceding description is for SAP2000. ETABS differs slightly. 

5.3 Detailed Display of Member Specific Information 
The program has the capability to display the design details for a specific 
member. The information includes member identification, shape name, section 
properties, design combination name, design combination forces, and other de-
sign input data to check the design results. The information also includes stress 
ratios for P-M-M and other interactions, demand/capacity ratios from shear, 
nominal strengths, design factors such as K1 (braced), K2 (sway), Cmz, Cmy, CmLT, 
Kz, Ky, KLT, and so forth. The design details are displayed in a summary form and 
also are displayed for a specific load combination and for a specific station of a 
frame member. 

When the design results are displayed on the model in the active window, the 
detailed design information can be accessed by right clicking on the desired 
frame member to display the Steel Stress Check Information form. Alterna-
tively, click the Design menu > Steel Frame Design > Interactive Steel 
Frame Design command and then right click on the frame member. An example 
of that form is shown in Figure 5-6.  
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Figure 5-6. A typical member specific steel stress check information summary 

The Steel Stress Check Information form identifies the frame members and the 
analysis and design section, and includes a display area of mostly de-
mand/capacity ratio data and a set of buttons that access forms that provide 
further details about the selected frame member. The display area reports the 
load combinations, the stress check stations, the P-M-M interaction ratio along 
with its axial and flexural components, and the shear stress ratios. The load 
combination is reported by its name, while the station is reported by its location, 
which is measured from the I-end of the column. The number of reported line 
items in the text box is equal to the number of design combinations multiplied by 
the number of stations. Only one line item is highlighted in blue when the form 
first displays. That item highlights the largest demand/capacity ratio from 
P-M-M, major and minor shear or any other considered interaction ratio, unless 
a line item(s) has design overstress or an error. In that case, the item with the 
overstress or error will be selected and highlighted. If many line items are 
overstressed or have an error, the last among all such line items will be selected 
and highlighted. 

 Detailed Display of Member Specific Information 5 - 9 



 Steel Frame Design IS 800:2007 
 

The stress check information is always reported for the design section. If the 
member is assigned an individual section, the analysis and design section are 
always the same. If the member is assigned an Auto Select Section (a list of 
sections), the analysis and design section can be different, unless the design has 
converged. 

The Overwrites and Details buttons near the bottom of the Steel Stress Check 
Information form can be used to access the Steel Frame Design Overwrites form, 
and the Steel Stress Check Data form, which displays detailed information about 
the selected frame element. While the latter form displays information in a 
non-editable format, the Overwrites form display the overwrite data in editable 
format. This allows the user to enter an interactive mode of design.  

 Overwrites button. Click this button to access the Steel Frame Design 
Overwrites form. Use that form to make revisions to the steel frame design 
overwrites and then immediately review the new design results as a summary 
using the Steel Stress Check Information form, or in detail by clicking the 
Details button to access the Steel Stress Check Data form. Clicking the OK 
button on the Steel Frame Design Overwrites form temporarily saves any 
changes. To make the changes permanent, click the OK button on the Steel 
Stress Check Information form. To disregard the changes, click the Cancel 
button on the Steel Stress Check Information form. An example of an Over-
writes form is shown in Figure 5-7. 

 Details button. Click this button to access the Steel Stress Check Data form. 
Use the form to review all of the design details for the highlighted item. An 
example of a Steel Stress Check Data form is shown in Figure 5-8. The in-
formation includes the member ID, load combo and station identifications, 
steel design sections, section properties, design combination forces, stress ra-
tios for P-M-M and other interactions, stress ratios for shear, nominal 
strengths, and design factors such as, K1 (braced), K2 (sway), Cmz, Cmy, CmLT, 
Kz, Ky, KLT, and so forth. Values that are not applicable are reported as N/A. 
Similarly, N/C and N/N indicate an item is “Not Calculated” and “Not 
Needed.” 
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Figure 5-7. A typical member specific Steel Frame Design Overwrites form 

 
Figure 5-8 A typical Steel Stress Check Data form 
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Before clicking the button, highlight an item for the desired design station and 
design load combination in the Steel Stress Check Information display area by 
clicking on the line. The data subsequently displayed will relate to the high-
lighted item. By default, the most critical line item is selected when the form first 
displays, as described previously. 

To increase or decrease the width of the Steel Stress Check Data form, put the 
cursor near the right edge of the form, click the left mouse button, and drag the 
mouse cursor towards the left or right. Similarly, the height of the form can be 
increased or decreased.  

The text in the form can be dragged in any direction by positioning the cursor in 
the middle of the form, and then clicking the left mouse button and dragging the 
text in the desired direction.  

Use the Units drop-down list in the upper right-hand corner of the form to 
change the units used to display the data. Data displayed on the form can be sent 
directly to the printer by selecting the File menu > Print command on the form. 
The program allows limited page setup options using the Print Setup Com-
mand on the File menu on the form.  

The Steel Stress Check Information form also includes a Tabular Data button 
that when clicked displays member specific design details in a spreadsheet type 
format. The tabular display of design information has been described in the 
previous section. In that case, the information displayed is specific to the se-
lected member only. The tabular output is shown for all stations and all design 
load combinations for the selected member. An example of design details table 
that displays after clicking the Tabular Data button is shown in Figure 5-9. This 
button is available in SAP2000, but not in ETABS. 
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Figure 5-9 Member specific design details in tabular format 

5.4 Save or Print Design Information as Tables 
In addition to model definition and analysis results, the design information for 
all steel frame members or for selected frames only can be saved in tabular 
format. Currently for “Indian IS 800:2007” code, the program saves design 
summary data, PMM design details, and shear design details.  

Save the file output by selecting the File menu > Print Tables command to 
access the Choose Tables for Printing form. An example of that form is shown in 
Figure 5-10. Use the options on the form to choose which table or set of tables to 
save in a file or print. This form is very similar to the Choose Tables for Display 
form, which has been described earlier in this chapter in the "Tabular Display of 
Design Information" section. 
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Figure 5-10 Choice of design tables for saving in a file or printing 

The name of the tables are displayed in a tree structure, which can be collapsed 
or expanded by clicking on an item in the tree. Click on the small check boxes 
preceding the items to select those tables for printing or saving to a file. If a 
branch of the tree is selected, all of the tables under that branch are selected.  
When all options for printing or saving the data to file have been specified, the 
settings can be saved as a Named Set using the Save Named Set button. The 
Named Set can be easily recalled in the future, reducing the need to reselect the 
options and ensuring that output is consistent from one printing effort to another. 

If one or more structural members are selected before the Choose Tables for 
Printing form is accessed, the Selection Only check box will be checked, and the 
program will save or print the data for the selected members only; uncheck the 
check box to save or print the data for all appropriate members. 
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The output can be generated in a variety of formats, including rich text format 
(.rft), plain text with and without splits or page breaks (.txt), and hyperlink text 
markup language (.htm) by choosing the appropriate option on the right side of 
the form.  

Printed output can be specified to have a landscaped orientation, in which the 
width of the resulting printout on a given page is longer than the height of the 
printout.  

Filtering criteria can be applied if those criteria were specified using the For-
mat-Filter-Sort menu > Format Table command when the selected data tables 
were displayed using the Display menu > Show Tables command. The output 
also can be specified to include a hyperlinked contents to facilitate accessing 
specific areas of the printout. 

There are other buttons on the form that do not affect saving or printing design 
information. For example, the Select Load Patterns button affects only sav-
ing/printing model definition data. The Select Load Cases and Modify/Show 
Options buttons affect only saving/printing analysis results. 

After clicking all the necessary tables for steel frame design and all necessary 
options, clicking the OK button will save/print the design tables. 

Although the File name > Print Tables command path is dedicated for sav-
ing/printing design information, it is not the only path to do so. Design tables can 
be saved in different formats using the path Display menu > Show Tables 
command. 

The preceding description applies to SAP2000. ETABS differs slightly. 

5.5 Error and Warning Messages 
Error messages and warnings may be displayed in the steel frame design output. 
Those messages and warnings are assumed to be self explanatory. 
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